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Transcript Manager provides tools so you can combine deposition audio and video with smooth scrolling 

transcripts to captivate the jury in a way that is virtually impossible with a printed transcript. Synchronized 

Digital Video Transcripts (DVTs), available from many litigation support firms nationwide, can be created from 

video and standard ASCII transcripts, making the advantages of using Transcript Manager immediately 

apparent. 

It's easy to create a clip. Search the transcript, highlight the text to be included in the clip, and you're one 

step away from creating a clip. Transcript Manager takes you from transcript search to a dynamic 

TrialDirector presentation in just a few clicks. You can also attach exhibits to a DVT, creating an integrated 

testimony presentation. 

Transcript Manager's capabilities extend beyond depositions. Most audio and video files that have a 

corresponding transcript, such as court proceedings, wiretaps or 911 dispatcher calls, can be converted into 

Digital Video Transcripts and can be used with Transcript Manager.  

Navigating Transcript Manager 
The Transcript Manager View menu allows the user to hide and display certain components 

of the main application window.  For example, the Case Explorer, Multimedia pane, 

Organizer and Word Index areas can be hidden in order to use the entire space for the 

Transcript Window. 

 

 

  

For detailed information about each component of the Transcript Manager, click on the 

component in the following table. 
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Component Description 

Transcript Toolbars  Two toolbars are available in the Transcript Manager: the Standard 

toolbar and the Multimedia toolbar. 

Transcript Explorer  The Transcript Explorer displays the Digital Video Transcripts 

(DVT's), multimedia files, transcript files, clips, segments, issues and 

exhibits associated with the open case. 

Organizer  The Organizer Window displays the status of the current session. If 

a Digital Video Transcript (DVT) is open, it will indicate the 

transcript, multimedia file, clip and segment are active. This is most 

important when creating or editing clips and segments. 

Transcript Viewer The Transcript Viewer displays the ASCII transcript when a 

transcript is open. The viewer has three tabs at the top. 

 The Transcript tab displays the entire transcript text. 

 The Clip Editor tab is the workspace where you can add and 

modify clips and related segments. 

 The Search tab allows you to search across multiple transcripts 

and conduct advanced searches. 

Multimedia Player  The Multimedia Player allows you to view and control the multimedia 

that corresponds to the selected transcript. 

Word Index  When you index the transcripts in your case, a list of every word in 

the transcripts appears in the Word Index. Hyperlinked page:line 

citations for each word appear for the currently displayed transcript. 

Exhibit Preview  Displays images of exhibits that have been attached to and 

synchronized with a transcript. 

   

Hiding Panels 
There may be times when you want more "real estate" on the desktop to view the transcript text. You can 
gain more space by closing the Multimedia Player, Transcript Explorer, Organizer or Word Index panel -- or 
all of them.  

 To hide the Transcript Explorer, Multimedia Player, Word Index or Organizer panel, click on the   
in the upper right corner of each panel 

 To show the Transcript Explorer or Multimedia Player again, click on the icon 

You may also select which panels to display or hide by going to the View menu in the 

Transcript Manager and selecting the appropriate panels. Note that the Transcript view will 

also be displayed. 
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Transcript Manager Toolbars 
Two toolbars are available in the Transcript Manager: the Standard toolbar and the 

Multimedia toolbar.  

 

To display the toolbars 

1. Open the View menu. 

2. Select Toolbars. 

3. Choose either Standard Toolbar, Multimedia Toolbar, or both.  

Transcript Manager Standard Toolbar 

  

 

    

Multimedia Toolbar 

  

 

  

Play - play (or restart play of)  current DVT 

Pause - pause playback 

Stop - stop playback 

Play Segment - play currently selected segment 

Play Clip - play currently selected clip (including all segments) 

Disconnect Multimedia - disconnects multimedia to allow for faster searching 

Toggle Audio - mutes or restores audio playback 

Toggle Closed Captioning - sets closed captioning environment 
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Transcript Explorer 

Topics: 

 Synchronize the Contents 

 Show and Hide the Case Explorer 

The Transcript Explorer displays files in a familiar tree structure, as shown in the figure below, and allows you 

to organize transcripts, clips, issue coding and exhibits attached to transcripts.  

The heirarchy within the Transcript Explorer tree is as follows: 

 The case name (e.g. Smith v. Jones) 

 A folder for each deposition, whether the deposition is synchronized or not 

 An entry for the ASCII (text) transcript) 

 Multimedia references (for depositions that have been synchronized) 

 Each Clip (including all segments created within a clip) created within the transcript 

 Exhibits from your case that are attached to the deposition testimony 

 A Virtual Clip containing the entire contents of the deposition.  

 

  

The virtual clip is circled in the graphic displayed below. The Virtual Clip provides a convenient means of 

opening the entire DVT from the Presentation mode. 
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Each clip appears as a separate folder within the Digital Video Transcript and can consist of one or more 

segments, which can be viewed separately or successively. All attached exhibits are contained in a folder 

within the Digital Video Transcript. 

The contents of each folder within the case can be displayed by clicking the plus sign (+) or double-clicking 

the icon to expand the folders. 

Synchronize the Contents 

When you have several DVTs, clips and segments in your case, you can easily identify the item you are 

working with in the Transcript Explorer by synchronizing the contents. When you synchronize the contents, 

the Transcript Explorer will highlight the active item being displayed in the active Transcript Manager viewer 

(e.g., the Transcript Explorer will highlight the item shown in the Organizer Window, if the Organizer window 

is the active element). 

For example, if you have a multiple versions of the same clip available and aren't certain which one you 

currently have open, synchronizing the contents will highlight the open segment in the Transcript Explorer. 

To synchronize the contents, click the Synchronize Contents button on the Transcript Explorer 

Toolbar or select Synchronize Contents from the View menu. 

Show and Hide the Case Explorer 

The Case Explorer is displayed along the left side of the application window when the Transcript Manager 

tab is active. 

To show the Case Explorer: 

 Select Case Explorer from the View menu 

To hide the Case Explorer: 

 Select View menu and deselect Case Explorer -- OR -- 

 Click the X in the upper right corner of the Transcript Explorer 
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Organizer Window 
The Organizer window provides information regarding the currently displayed transcript. If you opened a 

digital clip, the Organize Window will display something similar to the following: 

 

You can turn this display off at any time by selecting Organizer from the View menu or click the X button in 

the Organizer window.
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Searching Transcripts 
Transcript Manager provides four tools to use when searching transcripts.  

 Use the Find Tool to locate text, page and line references, and time codes within a single, open 

transcript.  

 Use the Search Tab to search for words or phrases across multiple transcripts. One benefit of using 

the Search Tab for searching one or more transcripts is that you can save your searches and print 

the results for the trial team. 

 Use the Word Index to locate individual terms and the number of times those terms appear in the 

currently open transcript. This is great when you're not sure how a name or term is spelled. 

 Finally, you can use Clipboard Linking to open and close transcripts, search for specific text that 

appears in a third-party program (such as an email or a Word document or a litigation support 

program), or locate a page and line reference. 

Search Using the Find Tool 

 Find Text/Phrase 

 Find Next Command 

 Find Question/Answer 

 Find Page/Line 

 Find a Timecode 

 Find a Deposition Video Marker 

The Find tool allows you to search for specific text/phrases, page and lines or timecodes in the currently 

open transcript. 

 

Tip: When searching a Digital Video Transcript, you can make searching faster by disconnecting the 

media. Open the Multimedia menu and select Disconnect Multimedia.Alternatively, just click on the X 

in the upper right corner of the Multimedia Player to hide it. To display the Multimedia Player again, 

click on the blue arrow on the far right side of the screen. 
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Find Text/Phrase 

To search for specific text in the currently open transcript: 

1. Click the Find tool on the Transcript Manager toolbar. You may also open the Edit menu and select 

Find. 

  

 

2. Enter the text or phrase you want to search for in the Find What field. 

Note: TrialDirector finds text that appears on a single line of the transcript. If the phrase you search for 
is split between two lines, the Find tool will not locate the phrase. 

3. Select the Match Case option to make the search case sensitive. 

4. Select the direction you want the search to run: Up or Down. This is based on the current position 

of the cursor in the transcript. 

5. Click Find Next to begin the search. The cursor in the Transcript moves to the first occurrence of 

the search term or phrase. 
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6. Click Find Next to move to the next occurrence of the search text. Click Cancel to cancel the 

search and close the Find dialog 

7. If you close the Find dialog, you can repeat the last find you performed by clicking on the Repeat 

Last Find tool on the toolbar.  

Find Next Command 

The Find Next command allows you to find the next occurrence of the most recently defined search criteria. 

To find the next search item, do one of the following: 

 Click the Find Next tool on the Toolbar. 

 Select Find Next from the Edit menu. 

If you have not already performed a search during your current TrialDirector session, the Find Next 

command will open the Find dialog. 
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Find Question/Answer 

Move through question-and-answer pairs in the currently open transcript using the Question and Answer 

tab. 

1. Click the Find Question-and-Answer tool on the Transcript Manager toolbar. You may also: 

 If the Find dialog isn't already open, open the Edit menu, select Find and open the 

Question/Answer tab. 

 You may also open the Edit menu, choose Find Specific, and select Find 

Question/Answer from the flyout menu. 

 

2. Select Question, Answer, or Question or Answer. 

3. Select the direction you want to search in the transcript: Up or Down. This is based on the current 

position of the cursor in the transcript. 

4. Click Find Next to find the next occurrence of a question or answer. To continue moving through 

the questions and answers, click Find Next again. Click Cancel to cancel the search and close the 

Find dialog. 

Find Page/Line 

Locate a specific page and line in a currently open transcript. 

1. Click the Find Specified Page and Line tool on the Transcript Manager toolbar. You may also: 

 If the Find dialog isn't already open, open the Edit menu, select Find and open the 

Page/Line tab. 

 You may also open the Edit menu, choose Find Specific, and select Find Page/Line from 

the flyout menu. 
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2. Enter the desired page and line number or use the up and down arrow buttons to increase or 

decrease the current page and line number selection. 

3. Click Find Next to jump to the identified location in the transcript. Click Cancel to cancel the search 

and close the Find dialog. 

Find a Timecode 

To find timecodes, the Digital Video Transcript must be time-stamped. To move through a Digital Video 

Transcript to a particular time: 

1. Click the Find Specified Time tool on the Transcript Manager toolbar. You may also: 

 If the Find dialog isn't already open, open the Edit menu, select Find and open the 

TimeCode tab. 

 You may also open the Edit menu, choose Find Specific, and select Find Time from the 

flyout menu. 

 

Note:  You can search across multiple multimedia reference files, using the total elapsed time of the 
Digital Video Transcript. 

2.  Enter the desired timecode or use the up and down arrow buttons to increase or decrease the 

timecode. The time is expressed in Hours:Minutes:Seconds (HH:MM:SS). 
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3. Click Find Next to jump to the selected time in the Digital Video Transcript. Click Cancel to cancel 

the search and close the Find dialog. 

Other (Beginning of Deposition Video Markers) 

Use the Other tab in the Find dialog to search for Beginning of Deposition Video Markers. Beginning of 

Deposition Video markers are embedded in a Digital Video Transcript when the media is changed during a 

proceeding. For example, if a deposition takes an entire day, there may be four separate video files 

associated with the transcript. When the change from one to the other occurs, the court reporter embeds a 

marker in the transcript to reflect the change. 

1. Open the Transcript menu and make sure Display Multimedia Breaks is selected.  

2. To search for a marker, select the Find tool on the toolbar or open the Edit menu and select Find. 

When the Find dialog opens, click the Other tab. 

 

  

2. Click Find Next to find the next marker. Click Cancel to cancel the search and close the Find 

dialog. 
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Search Using the Search Tab 

Use the Search tab in Transcript Manager to perform advanced searches on text in the currently open 

transcript, in selected transcripts, or in all transcripts. TrialDirector can help you quickly find even multiple 

keywords across dozens of transcripts. 

To Run an Advanced Search 

1. Click on the Search tab in the Transcript Manager. 

 

2. Enter the word, words or phrase you want to find in the Search For field. You don't need to type in 

"and" or "or". Capitalization doesn't matter. 

 TrialDirector uses an asterisk (*) as a wildcard character. The asterisk represents (1) no 

character or (2) any character. 

Example: To find all occurrences of the word exhibit -- including the plural exhibits -- enter 

exhibit* in the Search For field. If you do not use the asterisk, you will only find occurrences 

where exhibit appears, not exhibits. 

 The asterisk may be used in front of, at the end of, and in the middle of a search term. 

3. Identify which transcripts you want to include in the search by using the pull-down menu in the 

Search Within field: 

 To search all transcripts, select All Transcripts.  

 To select specific transcripts to search, click on the View By pull-down arrow in the 

Transcript Explorer panel and select Transcripts. Click the checkbox for each transcript you 

want to include in the search. 

 To search in the currently open transcript only, select Current Transcript Only. 

4. In the Search Method box, choose one of the following: 

 Exact Phrase Match to search the text exactly as it appears in Search For. 

 Match On All Words (AND) to find all of the words in Search For but not necessarily in the 

order in which you typed them. 

When this search method is selected, choose whether the words need to appear in the 

same Question/Answer pair or within a certain number of lines. 

 Match On Any Word (OR) to find all occurrences of any of the words entered in Search 

For. 

5. Click Search to run the search.  
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To Navigate the Search Results 

 To view the details of the search hits, expand the list of hits for any transcript by clicking the plus + 

sign next to the transcript name. Details include the number of hits found in each transcript and the 

page and line on which the search term appears. 

 

  

 To zoom into the transcript at the location of the search hit, hover your cursor over the text of the hit. 

The text becomes a hyperlink that you may click to jump to the transcript at that location. 
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 To jump to the beginning of any transcript listed in the Search Hits list, click on the Transcript 

Name. 

 To expand the search hit in order to view the question-and-answer pair containing the search 

term(s), click on the plus + sign next to the page and line number. Click on the - sign to compress 

the text again. 

 

  

  

Your search results remain on the Search tab until you close the case or run a different search. 

To Save Search Results 

You may want to retain a search that you use frequently or the results of which you want to print. 

1. Run the search. If you are satisfied with the results, click the Save button adjacent to the Search For 

box. 

2. When prompted, enter a description for your search. TrialDirector enters a description for you that 

consists of the search terms and the parameters of the search (the search method and the 

transcripts that were searched). 

3. Click Ok. 

4. You may view any Saved Searches by selecting Saved Searches from the View By pull-down menu 

in Transcript Manager. To run a saved search, double-click on the saved search. The search screen 

refreshes to display the search results. 

Note:  When you save a search, you are not saving the content of the search results. You are 

saving the search criteria. This means then that when new transcripts are added to your case, those 

transcripts will be included in the search as well if you choose All Transcripts as the Search Within 

selection. 
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To Print Search Results 

You can print saved search results in Summary mode or in Detailed mode. 

1. Locate the search result you want to print and run it. 

2. Click on the Print tool on the Transcript Manager toolbar or open the File menu and select Print. 

3. In the Print What area of the Print dialog, click on the pull-down arrow and select Search Results 

(Summary) or Search Results (Detailed). 

 Search Results (Summary) shows the name of each transcript in which there are hits, the 

page and line reference for the hit, and the first line of text, similar to the Search Results 

page before you expand any individual hits. 

 Search Results (Detailed) includes two options.  

 If you choose to print Only Displayed Results, any hits that you have expanded in 

the Search Results screen will be expanded in the printed report. Hits that were not 

expanded in the Search Results screen display as described above in Search 

Results (Summary).  

 If you choose to print All Search Results, all hits will print out in an expanded 

format. This may produce a lengthy report, depending on the total number of hits. 

Search Using the Word Index 

When you are at the main Transcript Manager screen, you can choose to display the Word Index.  

To Display the Word Index 

 Open the View menu and select Word Index, so that a check mark appears next to Word Index. 

The Word Index panel appears to the right of the transcript. 

To Search the Word Index 

You can navigate through the Word Index by: 

 Using the scrollbar to the right of the index 

 Typing the first letter of a word. The Word Index jumps to the first term beginning with that letter. 

 Enter an entire word into the Word Index search box at the top of the index. The Word Index will 

jump to that word in the list, where you will see page and line references for each occurrence of the 

word. 

 The page and line references are hyperlinks. Click on a page and line reference, and the cursor will 

move to that location in the transcript.  
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Search Using Clipboard Linking 

TrialDirector supports clipboard linking as a method of allowing other applications to find text, go to a 

particular page and line, open a Digital Video Transcript, or close a Digital Video Transcript. These features 

work from any third-party application simply by copying text to the Windows clipboard. If the copied text 

matches a certain format, TrialDirector performs the requested action. 

You can use Clipboard Linking from other litigation support programs (such as CT Summation iBlaze or 

Concordance), from Microsoft Office programs, or from Notepad or Wordpad.  

To experiment with Clipboard Linking: 

1. Click the Clipboard Monitor tool to activate clipboard linking. When the Clipboard Monitor is active, 

the tool button will be outlined in blue. 

2. Open a transcript in Transcript Manager within which you will conduct the search. 

3. Open Notepad and type the word exhibit into a blank note. 

4. Highlight the word exhibit in Notepad and press CTRL + C or open Notepad's Edit menu and select 

Copy. This automatically initiates a search for the word exhibit in the currently open transcript. 

5. To move through subsequent appearances of exhibit, be sure Notepad is the active window and 

press CTRL + C or open Notepad's Edit menu and select Copy. Transcript Manager moves 

through each occurrence of the word in the currently open transcript, returning to the first 

occurrence when it reaches the end of the transcript. 
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Clipboard Linking Commands 

The following table lists the commands available for Clipboard Linking: 

Command Description 

Open a Transcript Copy the following text string to the clipboard: 

!(DESCRIPTION) 

Replace DESCRIPTION with the name or a portion of the name 

of the transcript to be opened. TrialDirector opens the first 

transcript that matches the typed description. 

Close a Transcript Close the current transcript by copying the following text string 

to the clipboard: 

!() 

Find Page/Line With a transcript open, copy the following text string to the 

clipboard to find a specific page and line: 

#(PAGE,LINE) 

Replace PAGE,LINE with the page number and line number, 
separated by a comma, that you want to move to. 
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Multimedia Controls 

 



TrialDirector 6 Help - Preparing Transcripts  

24 Copyright ©2011 inData Corporation. All Rights Reserved. 

Working with Transcript Clips 
Transcript clips are excerpts of transcript testimony. Clips can be made from any transcript, even if the 

transcript has not been digitized and synchronized. The results are simply different.  

 If the transcript from which the clips are made is a DVT (with accompanying video), in Presentation 

mode, the clipped text will scroll on the screen along with a video window showing that portion of 

the videotaped testimony. See Presentation Preferences  for information 

about the formats you may choose for displaying the video and text together.  

 

 If the transcript does not include associated video, the clip excerpt is displayed in Presentation 

mode as an image that can be annotated, provided you create the clip using the One Step Clip 

Creation process. 
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Click on any of the following links to get detailed help with Transcript Clips: 

General Function Specific Function 

Creating and Editing Clips Creating Clips 

  Adding Segments to a Clip 

  Working with the Clip Editor  

  Working with Attached Exhibits 

  Removing Clips or Segments 

  Copying and Moving Segments to Another Clip 

  Changing Clip Properties 

Navigating Clips Opening and Closing Existing Clips 

  Multimedia Controls 

Managing Clips Exporting Clips to Clip Creation Script  

  Exporting Clips 

  Setting Options for Clips 

Playing and Presenting Clips Playing a Clip 

  Presenting a Clip in Presentation Mode 
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Creating Clips 

TrialDirector offers several methods for making clips. Click on any of the links for detailed instructions: 

 Creating a Clip in One Step 

 Creating Clips Using the Clip Editor 

 Creating Clips Using the Clip Wizard 

 Creating Clips Using Issue Codes 

 Creating Clips Using a Clip Creation Script 

 Creating a New Clip Container 

 Creating Clips from the Clipboard 

Creating a Clip in One Step 

1. Locate the text in the transcript to be included in the clip, then place the cursor to the left of the first 

transcript line number to be included in the clip, click and drag the highlighting to the end of the last 

line of transcript text. 

2. Right-click on the highlighted text and select Create New Clip from Selected Text. The clip will be 

created automatically without any additional user interaction. The new clip is automatically opened 

for review, editing or presentation. 
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Note:  By default, TrialDirector names clips using the following format: JD-0207-0000905 (first 

and last initials, month and day of deposition, zero-filled page and line numbers). You can change 

how the clip is named. Click here for instructions on changing this setting.  

Creating Clips Using the Clip Editor 

You can use the Clip Editor to quickly create multi-segment clips, which is especially useful 

when you are provided with a list of page:line references for designations, for example. 

First, you'll create a Clip Container and then you'll add segments to the clip. 

1. Locate the transcript in the Transcript Explorer in which you need to create clips. Double-click on 

ASCII Transcript for [deponent]. The selected transcript text appears in the Transcript panel. 

2. Find the first transcript excerpt you wish to turn into a clip. Highlight the text (beginning from just to 

the left of the first line number and ending just to the right of the last line of testimony). 

3. Click on the Clip Editor tab and click on the New button. A dialog opens with the default Clip 

Identifier (first initial, last initial, month/day of deposition, zero-filled page and line) and the Clip 

description (first line of the clip). 
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 Modify the Clip identifier and the Clip description, if you wish. If you do modify the clip 

identifier though, make sure the identifier is unique. You may not have two clips with the 

same clip identifier. 

4. Click Create to create the Clip Container or hit Cancel to close the dialog. The Clip Editor displays 

the clip identifier for the Clip Container under Clip Properties but no segments appear in the Clip 

Segments section of the Clip Editor. 

 If you want to modify the clip identifier, you may enter a new Identifier in the Clip Properties 

section of the Editor. Click Update to save your change. 

 

 

5. To add one or more segments to the clip you just created, enter the beginning page:line reference in 

the Add from box and enter the ending page:line reference for the segment in the To box. Click the 

+ button to add the segment to the current clip. The segment is added to the Clip Segments pane 

and the text contents of the clip appears in the Review Clip Text pane of the Editor. 
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6. You may continue to add segments to the current clip by entering the beginning page:line and 

ending page:line details in the Add from: ... to ... boxes. Remember to click the + sign to add 

each segment to the current clip. 

Creating a Clip Using the Clip Wizard 

Similar to creating a clip using the Clip Editor, you can create a clip using the Clip Wizard by selecting the 

transcript line or timecode ranges you want to include in each segment. Again, this technique is useful when 

you are provided with a list of page:line references. 

1. Locate the transcript in the Transcript Explorer in which you need to create clips. Double-click on 

ASCII Transcript for [deponent]. The selected transcript text appears in the Transcript panel. 

2. Find the first transcript excerpt you wish to turn into a clip. Highlight the text (beginning from just to 

the left of the first line number and ending just to the right of the last line of testimony). 

3. Select Clip Wizard from the Clips menu. 
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 If you are using a 10-key pad to enter segment starts and stops, use the period character to 

separate the page and line references. If you are using the row of numeric keys on the 

keyboard, you may use either the period or a colon to separate the page and line references 

when entering page-line references.  

  

 The default format for defining clip segment boundaries is by Page/Line reference. Example: 

Where the page/line reference is 00004:07, 00004 is the page number, 07 is the line 

number. 

 Click the Page/Line format button to switch to TimeCode reference format. Example: 

Where the Timecode reference is 03:40:15, 03 represents the hours, 40 represents the 

minutes, and 15 represents the seconds. 

 Click the TimeCode format button again to switch back to Page/Line format. 

4. Enter the desired beginning and ending segment positions and click Add or hit the Enter key on 

your keyboard. The defined segment is added to the clip. 

5. Repeat step 4 to add more segments to the clip. 

When you are finished, the window will look similar to the following: 

 



TrialDirector 6 Help  Preparing Transcripts 

 Copyright ©2011 inData Corporation. All Rights Reserved. 31 

 To change the segment position in the clip, click to select the desired segment and click Up 

to move it up one segment or Down to move it down one segment. Doing so changes the 

order in which the segments play in the clip.  

 To delete a segment, select the desired segment and click Delete. Click Yes to delete the 

segment or No to cancel the deletion. 

 

6. Click Next when you have finished adding segments to the current clip. 

 

  

Note:  By default, TrialDirector names clips using the following format: JD-0207-0000905 

(first and last initials, month and day of deposition, zero-filled page and line numbers). You can 

change how the clip is named. Click here for help with changing the Clip Identifier settings. The 

Clip Identifier is the same as the Object ID in Transcript Manager and is used to pull up the clip 

in Presentation mode. Because of this, you may want to edit the identifier so that it is 

consistent with your established naming convention.  

  

7. Click Next to continue. 
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8. Modify page/line adjustments, if necessary. 

 Check Allow segments from multiple multimedia streams if your clip spans more than 

one multimedia file. (If the Split Segments at Multimedia Break option is selected in the 

Clip Options, this option will be preselected for you.)  

 To automatically adjust the beginning and ending positions of the clip segments, select 

Automatically Adjust Page/Line Segment(s). Use the arrow buttons to increase or 

decrease the start and end segment adjustments by one second at a time. If the 

timestamps within the DVT are accurate, the created clip should need only minimal fine 

tuning. 

 If you are using script timecodes, adjusting segment time codes is not recommended. 

9. Click Next to confirm the segment adjustment selections. 

 

  

10. Click Create to create the clip. 

11. When the progress bar reaches the end, click Next to continue. 
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13. Review the clip creation results to ensure that the process was completed successfully. Click OK to 

exit the Clip Wizard or click New Clip to create another clip. 

Creating Clips Using Issue Codes 

You can create clips from issue codes that are applied to your transcripts. See Working with Issues  for 

detailed instructions on creating and assigning issues to transcript text. 

1. From the Clips menu, select the Create Clips from Issue Codes. 

2. Select the issue codes that you would like to use to create clips. 

 

3. Select the transcripts from which the clips will be generated. 
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4. If necessary, make adjustments to the start and stop times of the clips. Click Next to continue. 

 

5. Click Create to begin the clip creation process then, when the progress bar reaches the end, click 

Next. Confirm that the clip has been created and, if so, click OK. 

 Any clips created using Issue Codes are now added to the Clips folder for the individual 

transcripts in the Transcript Explorer. 

 

Tip: Consider assigning issues for designations. For example, one issue may be Plaintiff's 

Designations; another may be Defendant's Designations; another may be Disputed 

Designations. Assign the appropriate colors to the issues. This trick makes playing designated 

clips a simple process. 
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Creating Scripts Using a Clip Creation Script 

A Clip Creation Script file (*.ccs) is a text file that can be used to create multi-segment clips automatically. A 

script file also lets you open Digital Video Transcripts and override the default clip identifiers and/or 

descriptions generated by the Transcript Manager. 

1. Open the Clips menu in the Transcript Manager and select Execute Clip Creation Script (*.ccs). 

2. Click Browse to navigate to the desired Clip Creation Script (*.ccs) file. The source script may be 

located on a local or external hard disk, USB drive, network drive or UNC path. It does not have to 

be stored within the case files. 

3. In the Windows Browse dialog, select the desired *.ccs file and click Open or double-click on the 

filename.  

4. When the correct path and filename is displayed in the Clip Creation Script dialog, click Next to 

continue. 

5. Modify page/line adjustments, if necessary. 

 Check Allow segments from multiple multimedia streams if your clip spans more than 

one multimedia file. (If the Split Segments at Multimedia Break option is selected in the 

Clip Options, this option will be preselected for you.)  

 To automatically adjust the beginning and ending positions of the clip segments, select 

Automatically Adjust Page/Line Segment(s). Use the arrow buttons to increase or 

decrease the start and end segment adjustments by one second at a time. If the 

timestamps within the DVT are accurate, the created clip should need only minimal fine 

tuning. 

 If you are using script timecodes, adjusting segment time codes is not recommended. 

 To use the timecodes embedded in the script file, select the Use script timecodes for 

segments if available option. 

 

6. Click Next to confirm the segment adjustment selections. 

7. If the deponent name is not specified within the script, the transcript referred to in the Clip Creation 

Script must be open. 
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8. Click Execute to begin creating clips using the script file. When the progress bar 

reaches the end, click Next to continue. 

9. A confirmation dialog opens. If the script was executed successfully, you will see that message. Any 

errors encountered by TrialDirector will be displayed at this point. (For example, if TrialDirector can't locate 

the DVT, you will see an error message.) If there are no errors, click OK to close the script and return to the 

Transcript Manager desktop. 

Creating a New Clip Container 

TrialDirector allows you to create empty clips to which text selections can be added as segments at a later 

time. 

1. Open the desired transcript. 

2. Choose Create a New Clip from the Clip menu. 

 

 The Clip Identifier defaults to the Deponent Initials - Deposition Date - Page|Line reference of 

the newly created clip. 

 Both the clip description and the clip identifier can be modified, if desired. 

3. Click Create to create the new clip or Cancel to exit. The clip is created and opened, but remains 

empty until you add segments.
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Creating Clips from the Clipboard 

If you receive clip page/line designations in other applications, such as Microsoft Word, you can copy and 

paste the designations in to TrialDirector to quickly create multi-segment clips.  

 

To create clips from the clipboard 

1. Open the applicable transcript in your TrialDirector case. 

2. From the other application (such as Word), copy the clip page/line designations. 

3. In TrialDirector Transcript Manager, on the Clips menu, click Create Clips Using Clipboard. 

4. In the Paste a New Clip dialog box, enter a Clip identifier and Clip description. 

5. In the Segment(s) box, use CTRL+V to paste the segment designations. 

Your designations can be in a variety of formats (Page.Line, Page:Line, Page-Line, etc.). Non-

designation text is automatically flagged for removal. 

 

Below is an example of pasted designations. 

 

6. Click Create. 
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Adding Segments to a Clip 

A clip is made up of one or more segments. Segments can be added to new or existing clips, and there is 

no limit to the number of segments that can be added to a clip. 

To add segments to a clip 

1. Highlight the transcript text you want to add as a segment to the currently open clip. 

2. Use one of the following methods 

 Click the Add Selected Text To Current Clip tool   on the Transcript Manager toolbar 

 Select Add Selected Text To Clip [Clip ID] from the Clips menu 

 Right-click on the highlighted section of text in the transcript window and choose Add 

Selected Text To Clip [Clip ID] from the shortcut menu  

-- OR -- 

 Click on the Clip Editor tab, click the Open button, select the clip you want to supplement 

and click Open (or double-click on the clip), then enter the beginning and ending page:line 

references in the Add from...to... boxes. Click the green + to add the segment to the 

current clip. 

The segment is added to the open clip. 
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3. Add additional segments as desired. 

4. Once the segments are created, review the segments to confirm the beginning and ending points of 

each one is accurate. If they are not, you will need to adjust the starting and ending times. See 

Working with the Clip Editor for instructions. 
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Working with the Clip Editor 

Clips are fragments of extracted testimony. When presenting evidence in court, attorneys use clips to distill 

testimony to key excerpts. Clips are often made up of multiple segments, where objections or long pauses 

are eliminated.  

Clips may be made of transcripts that have no associated video, which results in the creation of an image of 

the transcript lines that can be annotated during presentation.  

But the Clip Editor focuses on managing and editing clips associated with digitized video transcripts (DVTs). 

Digital video transcripts are synchronized with the video so that, as the deponent or witness is speaking, the 

transcription of their testimony scrolls along with the video, similar to the way closed captioning works on 

your television. Usually, synchronization is very accurate, but occasionally, the video may not have been 

synchronized perfectly. When this occurs, the beginning and ending portions of a segment or clip might be 

chopped off or extended into the next line of text. The Clip Editor helps you fix these kinds of issues. For 

situations where the synchronization is very poor, you may need to resynchronize the video with the 

transcript using TimeCoder or TimeCoder Pro. 

  

 

Tip: It is always recommended that you review each segment of each clip before presenting clips in 

court to be sure of the accuracy of the timing of the clips. 

  

For detailed instructions on making clips, click here.  For a list of supported multimedia file formats, see the 

TrialDirector Help. 

Click on any of the following links for details on working with the Clip Editor's features: 

Navigating the Clip Editor 

Creating a Clip in the Clip Editor 

Opening a Clip in the Clip Editor 

Adding Segments to a Clip 

Rearranging Segments in a Clip 

Removing Segments from a Clip 

Editing Segment Start and Stop Times 

Modifying Segment Start and Stop Lines 

http://www.indatacorp.com/Products/Video/timeCoderPro.aspx


TrialDirector 6 Help  Preparing Transcripts 

 Copyright ©2011 inData Corporation. All Rights Reserved. 41 

Navigating the Clip Editor 

When you select the Clip Editor tab in the Transcript Manager, you may see a screen similar to the one 

shown here. Click on any of the text boxes in the screenshot to see detailed information about that portion of 

the screen. 
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Clip Editor Features 

 

  

 

The Seek to Start button will immediately seek to the beginning of the current clip segment to verify that it 

begins at the appropriate location. The Seek to End button will seek to 3 seconds prior to the end of the 

segment to ensure that it ends at the correct location. These tools are very handy to quickly spot-check clip 

segment accuracy. 
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Segment Editor Features 

 

 

 

Note:  In TrialDirector v6.3, new functionality in the Transcript Manager Segment Editor enables you to 

seek backward/forward (in 5-second increments) within the audio waveform for either the segment start or 

segment end locations. This functionality is especially handy when attempting to edit clip segments with 

long periods of silence. 
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Visual Segment Editor Synchronized with Multimedia Player 

Using the visual waveform segment editor, each time you move the yellow dotted line to a new position, the 

associated video will also seek to the same location. This functionality is very beneficial to acquire a visual 

queue on how a clip segment will begin or end. It will allow the clip editor to quickly see any deponent 

gestures or movements that might be ruled as prejudicial. 

EXAMPLE: 

Setting the yellow dotted line to the position show below will automatically seek the associated video to the 

same location. The clip editor can then quickly determine that there is a hand gesture that may be best 

excluded from the clip. The editor can then easily move the yellow line ahead to eliminate as much of the 

gesture as possible prior to the deponent answering the question. 
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Creating a Clip in the Clip Editor 

Use the Clip Editor to quickly create multi-segment clips, which is especially useful when you are provided 

with a list of page:line references for designations, for example. First, you'll create a Clip Container and then 

you'll add segments to the clip. 

1. Locate the transcript in the Transcript Explorer in which you need to create clips. Double-click on 

ASCII Transcript for [deponent]. The selected transcript text appears in the Transcript panel. 

2. Find the first transcript excerpt you wish to turn into a clip. Highlight the text (beginning from just to 

the left of the first line number and ending just to the right of the last line of testimony). 

3. Click on the Clip Editor tab and click on the New button. A dialog opens with the default Clip 

Identifier (first initial, last initial, month/day of deposition, zero-filled page and line) and the Clip 

description (first line of the clip). 

 

 Modify the Clip identifier and the Clip description, if you wish. If you do modify the clip 

identifier though, make sure the identifier is unique. You may not have two clips with the 

same clip identifier. 

4. Click Create to create the Clip Container or hit Cancel to close the dialog. The Clip Editor displays 

the clip identifier for the Clip Container under Clip Properties but no segments appear in the Clip 

Segments section of the Clip Editor. 

 If you want to modify the clip identifier at this point, you may enter a new Identifier in the Clip 

Properties section of the Editor. Click Update to save your change. 
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5. To add one or more segments to the clip you just created, enter the beginning page:line reference in 

the Add from box and enter the ending page:line reference for the segment in the To box. Click the 

+ button on the Clip Segments Toolbar to add the segment to the current clip. The segment is 

added to the Clip Segments pane and the text contents of the clip appears in the Review Clip Text 

pane of the Editor. 

 

 

6. You may continue to add segments to the current clip by entering the beginning page:line and 

ending page:line details in the Add from: ... to ... boxes. Remember to click the + sign on the Clip 

Segments toolbar to add each segment to the current clip. 

 

 

Opening a Clip in the Clip Editor 

1. Click on the Open button in the Current Clip section of the Clip Editor. 

2. The Open a Clip dialog opens. You can sort by either Object ID (clip identifier) or Description by 

clicking on the appropriate column heading. By default, the clips are sorted by ObjectID. 
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3. Select the clip you want to open and click Open or double-click on the clip identifier. To exit without 

opening a clip, click Cancel. 

Adding Segments to a Clip 

1. Open the clip in the Clip Editor. 

2. Enter the beginning page:line reference in the Add from box and enter the ending page:line 

reference for the segment in the To box.  

3. Click the + button on the Clip Segments toolbar to add the segment to the current clip. The 

segment is added to the Clip Segments pane and the text of the clip appears in the Review Clip 

Text pane of the Editor. 
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Rearranging Segments in a Clip 

You may want to rearrange the order in which segments in a clip play. 

  

1. In the Clip Segments window, hold the left mouse button down on the segment you want to 

reposition so that it is selected. 

2. Drag the selected segment to the new location and release the mouse. 
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Removing Segments from a Clip 

1. In the Clip Segments window, select the segment(s) to be deleted. You may use the CTRL key to 

select multiple non-contiguous segments or the SHIFT key to select multiple contiguous segments. 

2. Right-click on the segment to be deleted and select Delete or click the button on the Clip 

Segments toolbar. 

3. You will be asked to confirm the deletion. Click Yes to delete the clips; click No to cancel the 

deletion. 

Editing Segment Start and Stop Times 

You can edit segments in the clip so that each segment will begin and end precisely where 

you intend it to begin and end when the clip is shown in Presentation Mode. Use the 

WaveForm Editor (shown below) to modify the segment start and stop times.  

  

 

Note: A small number of file types are not supported by the Waveform Editor. If the segment you are 

editing uses one of these formats, the message "Unsupported Multimedia Format" will display in the 

lieu of the waveform display. 

  

 

Note:  You may have used the VCR controls in earlier versions of TrialDirector to perform the same 

task. In TrialDirector 6, the Segment Editor now contains all the controls you need to modify the 

segment start:stop times, including easy-to-use segment start and stop counters. 

1. Select the Clip Editor tab and open the clip you want to edit so the clip's segments appear in the 

Clip Segment(s) window. 

2. Click the Adjust Selected Segment button  on the Clip Segments toolbar to open the 

Segment Editor. Within the Segment Editor, you will see the WaveForm editing tools and the Adjust 

Segment Text window for the currently selected segment. The WaveForm editing tools are used to 

adjust the start and stop times of a segment. The Adjust Segment Text tool is used to adjust the 

start and stop lines of a segment. 
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Note:  In TrialDirector v6.3, new functionality in the Transcript Manager Segment Editor enables you to 

seek backward/forward (in 5-second increments) within the audio waveform for either the segment start or 

segment end locations. This functionality is especially handy when attempting to edit clip segments with 

long periods of silence. 

 

 

 

 

3. To Review the Segment: 

 To review the start point, click Play   in the controls below the Adjust Segment Starting 

Time panel. The first three seconds of the segment will play, and you will see the 

corresponding video in the Multimedia Player panel. If an exhibit is attached to that portion 

of the testimony, it will appear in the Exhibit Preview panel.  

 To review the end point, click Play   below the Adjust Segment Ending Time panel. The 

last three seconds of the segment play. The first three seconds of the segment will play, and 
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you will see the corresponding video in the Multimedia Player panel. If an exhibit is attached 

to that portion of the testimony, it will appear in the Exhibit Preview panel.  

4. To Increase/Decrease Silence: 

 

 

 To increase the silence at the beginning or end of the segment, drag the yellow endpoint 

editor left (or right) toward a blank area of the waveform. You'll need to do this if the 

segment starts or ends in the middle of a word or phrase. 

 To decrease the amount of silence at the beginning or end of the segment, drag the yellow 

endpoint editor right (or left) toward the waves depicting speaking or sound. 

 You may also want to use the Segment Start Time and Segment End Time counters to 

adjust the beginning and ending points of the segments. The counters display the segment 

start and end times in hours:minutes:seconds:milliseconds. Left-click on the appropriate 

number, and the yellow endpoint editor will move left. Right-click on the appropriate 

number, and the yellow endpoint editor will move right. 

5. When the segment start point is correct, click to Save the edited Segment Starting Time.   

6. When the segment end point is adjusted as you want it, click to Save  the Segment Ending 

Time.  

Modifying Segment Start and Stop Lines 

During the process of reviewing segments, you or the attorney may realize that the segment should be 

extended to lines above or below the current segment or, maybe, the segment should be shortened.  
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1. Select the Clip Editor tab and open the clip you want to edit so the clip's segments appear in the 

Clip Segment(s) window. 

2. Click the Adjust Selected Segment button  on the Clip Segments toolbar to open the 

Segment Editor. 

 The text shown in black, bold type is the text contained within the current segment. The 

gray text shows 10 lines of text above and below the current segment text. 

 

 

3. Review the text surrounding the current clip and determine the new page:line designations for the 

segment. Enter the new beginning and ending page:line references in the Adjust Segment from: ... 

to ... boxes. 

4. Click Update to save the changes. The new page and line designations are reflected in the Clip 

Segments window.  

5. Test the start and end times for the segment. If necessary, adjust the start and end times using the 

WaveForm Editor or the Segment Start and End counters. 
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Working with Attached Exhibits 

Exhibits can be attached to specific testimony in transcripts. For example, when a deponent refers to a 

particular deposition exhibits, provided that exhibit is loaded into TrialDirector, you can attache the exhibit to 

the relevant testimony. When you are working in Transcript Manager, attached exhibits display in the Exhibit 

Preview pane, located in the lower right corner of the Transcript Manager. When the Digital Video Transcript 

is played in Presentation mode, the exhibit attachments are automatically displayed.  

Note: An attached exhibit is associated with the transcript lines to which it is attached. It is not 

associated with an individual clip. This means that an attached exhibit will be displayed when TrialDirector 

reaches the point where the exhibit was attached to the transcript, regardless of which clip is being played. 

Setting Up to Display Attached Exhibits 

 Open the Transcript menu and select Display Attached Exhibits 

 Open the View menu, select Options, and select Show Attached Exhibits and Synchronize 

Exhibits 

Attaching Exhibits to Transcripts 

1. Confirm the Display Attached Exhibits option is enabled under the Transcript menu. 

2. Place the cursor at the desired insertion point on the transcript.  

Note: Do not attach an exhibit to the first line of a clip. Attach the exhibit two or three lines from 

the top of the clip. 

3. Right-click and select Attach Synchronized Exhibit... or open the Transcript menu and select 

Attach Synchronized Exhibit. 

4. In the synchronized exhibit dialog, enter a description of the exhibit and the exhibit identifier. 

(These fields will be pre-filled with the description and item ID of an item that may be currently 

selected in the Document Manager or Case Explorer.) Click Next. 

5. Select Use current audio/video position option to display the exhibit at a precise time within the 

deposition. Otherwise, Use the current transcript line is selected by default. 

 The exhibit attachment can be synchronized with the timecode associated with the 

transcript line where the cursor is currently positioned or it can be synchronized with the 

current time that appears in the Multimedia Manager. 

6. Click Attach to associate the exhibit with the transcript or Cancel to cancel the process. You can 

also click Back to return to the previous window. The attachment will appear as hidden text (green) 

in the transcript. The exhibit identifier is added to the Exhibits folder for the transcript in the 

Transcript Explorer pane. 
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Note: If you try to attach an exhibit at a point in the transcript that is not synchronized with the 

multimedia (e.g., the title and appearances pages), the following window will appear: 

 

 Click OK to return to the Transcript Manager tab. Position the cursor at a properly timecoded and 

synchronized point in the transcript and try again. 

Clearing Attached Exhibits 

During Presentation playback, it is important to close the exhibit before moving onto another clip. This is 

even more critical when you are using a MultiPlayer Workbook. If the exhibit is not cleared, the MultiPlayer 

Workbook will not automatically move to the next item in the workbook. When you clear an exhibit, you are 

simply closing it. If you want to remove the exhibit from the transcript, see Removing Attached Exhibits 

below. 

1. Locate the point in the testimony where the exhibit no longer needs to be displayed. Place your 

cursor on the appropriate line. 

2. Right-click and choose Clear Synchronized Exhibit or open the Transcript menu and select Clear 
Synchronized Exhibit.  
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Removing Attached Exhibits 

1. Make sure you can see the exhibit text markers in the transcript. If not, open the Transcripts menu 

and select Display Attached Exhibits. 

 

 

2. Click on the marker for the exhibit you want to remove. Right-click on the marker and select 

Remove Exhibit from the shortcut menu or open the Transcript menu and select Remove 

Synchronized Exhibit. 

3. When prompted to remove the attached exhibit, click Yes to remove the exhibit attachment or No to 

cancel the removal. This does not remove the item from the case; it simply removes the link in the 

transcript to the exhibit. 

Opening an Attached Exhibit 

1. Locate the Exhibits folder for the transcript in the Transcript Explorer pane. Double-click on the 

appropriate exhibit identifier. 

2. The selected exhibit is displayed in the Exhibit Preview pane. TrialDirector jumps to the point in the 

video and transcript where the exhibit is attached, as long as synchronization is enabled. See 

Setting Up to Display Attached Exhibits . 

Viewing a Synchronized Exhibit in Transcript Manager 

1. To enable exhibit synchronization, click on the Enable or Disable Exhibit Synchronization tool 

on the Transcript Manager toolbar, if it is not already enabled. (When a tool is enabled, it is 

surrounded by a blue outline.) You may also open the Transcripts menu and select Linked Exhibit 

Synchronization. 

2. To view the exhibit markers in the transcript, open the Transcripts menu and select Display 

Attached Exhibits. 

3. Play the portion of the transcript that contains an exhibit attachment. When the transcript reaches 

the exhibit attachment, the exhibit will be automatically displayed in the Exhibit Preview pane, as 

shown in the figure below. 
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Enabling and Disabling Exhibit Synchronization 

To enable exhibit synchronization: 

 Select Digital Video Synchronization from the Transcript menu -- OR -- 

 Click the Enable or Disable Digital Video Synchronization tool on the Transcript Manager toolbar. 

The tool will display a blue outline when it is enabled. 

To disable exhibit synchronization: 

 Deselect the Digital Video Synchronization from the Transcript menu -- OR -- 

 Click the Enable or Disable Digital Video Synchronization tool on the Transcript Manager toolbar 
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Removing Clips or Segments 

You can remove entire clips or individual segments within a clip. Be aware that when you delete a segment 

or clip, the deletion is permanent and cannot be undone. 

Removing a Clip 

To remove a single clip from the Transcript Explorer: 

1. Make sure the clip to be removed is not currently open. If it is, you won't be able to delete it.  

2. Right-click on the clip identifier and select Delete from the shortcut menu. 

3. You will be asked to confirm the deletion. Click Yes to delete the clip; click No to cancel the 

deletion. 

To remove a single clip from the Clips Panel: 

1. Make sure the clip to be removed is not currently open. If it is, you won't be able to delete it. 

2. In the View by box, select Clips from the drop-down menu. 

3. Select the clip you want to delete, open the Clips menu, and select Remove Select Clip(s) or right-

click on the selected clip identifier and choose Delete from the shortcut menu. 

4. You will be asked to confirm the deletion. Click Yes to delete the clip; click No to cancel the 

deletion. 

To remove multiple clips: 

1. Make sure none of the clips to be removed is currently open. If one of the clips is open, you won't 

be able to delete the clips. 

2. In the View by box, select Clips from the drop-down menu. 

3. Select the clips you want to delete. You may use the CTRL key to select multiple non-contiguous 

segments or the SHIFT key to select multiple contiguous segments. 

4. Open the Clips menu and select Remove Select Clip(s) or right-click on one of the selected clip 

identifiers and choose Delete from the shortcut menu. 

5. You will be asked to confirm the deletion. Click Yes to delete the clips; click No to cancel the 

deletion. 

Removing a Segment 

To remove a single segment from the Transcript Explorer: 

1. Expand the appropriate clip folder. 

2. Within the clip folder, right-click on the segment to be removed. 

3. Select Delete from the shortcut menu. 

4. You will be asked to confirm the deletion. Click Yes to delete the clips; click No to cancel the 

deletion. 
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To remove one or more segment(s) using the Clip Editor: 

1. Select the Clip Editor tab. 

2. In the Clip Segments window, select the segment(s) to be deleted. You may use the CTRL key to 

select multiple non-contiguous segments or the SHIFT key to select multiple contiguous segments. 

3. Right-click on the segment to be deleted and select Delete or click the button on the Clip 

Segments toolbar. 

4. You will be asked to confirm the deletion. Click Yes to delete the clips; click No to cancel the 

deletion. 
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Copying and Moving Segments 

There may be times when you want to copy or move one or more segments from one clip to another. In the 

Transcript Manager, you can accomplish this from the Transcript Explorer or from the Clip Editor. Use the 

Transcript Explorer to copy or move a single segment, and use the Clip Editor to copy or move one or more 

segments. Copied segments may be placed anywhere within a clip and do not necessarily have to follow in 

sequence. 

Copying a Single Segment within the Transcript Explorer 

1. Expand both the clip containing the segment you want to copy and the clip to which you want the 

segment copied. 

2. Click to select the segment and drag it from the current clip to the new clip location. The segment is 

copied, not moved. (See Moving Segments below to move a segment from one clip to another.)  

 You can also right-click on the segment, select Copy from the shortcut menu, then right-

click on the segment just above where you want the segment copied, and select Paste. 

Copying One or More Segments using the Segment Editor 

1. Click on the Clip Editor tab to open the Editor. 

2. If the clip containing the segment to be copied is not currently open in the Clip Editor, click Open to 

locate the clip. 

3. In the Clip Segments window, select the segment(s) you want to copy. You may use the CTRL key 

to select multiple non-contiguous segments or the SHIFT key to select multiple contiguous 

segments. 

4. Locate the clip to which you want to copy the segment. Expand the clip so that you can see the 

individual segments. 

5. Right-click on the segment after which you want to copy the segment and select Paste. 
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Moving Segments 

To move a segment using Transcript Explorer: 

1. Expand both the clip containing the segment you want to cut and the clip to which you want the 

segment moved. 

2. Right-click on the segment to be moved, select Cut from the shortcut menu, then right-click on the 

segment just above where you want the segment moved and select Paste. 

To move one or more segments using the Clip Editor: 

1. Click on the Clip Editor tab to open the Editor. 

2. If the clip containing the segment to be moved is not currently open in the Clip Editor, click Open to 

locate the clip. 

3. In the Clip Segments window, select the segment(s) you want to move. You may use the CTRL key 

to select multiple non-contiguous segments or the SHIFT key to select multiple contiguous 

segments. 

4. Locate the clip to which you want to copy the segment. Expand the clip so that you can see the 

individual segments. 

5. Right-click on the segment after which you want to copy the segment and select Paste. 



TrialDirector 6 Help  Preparing Transcripts 

 Copyright ©2011 inData Corporation. All Rights Reserved. 61 

Changing Clip Properties 

You can modify the Object Identifier (the Clip Identifier) and the Clip Description after you have created a clip 

using the Clip Properties dialog. Two tabs appear in the Clip Properties dialog box: General (for changing the 

description and clip identifier) and Extended (for modifying the Display Mode Override options). 

To access Clip Properties 

1. Locate the clip in the Transcript Explorer. 

2. Right-click on the clip identifer and select Properties from the shortcut menu. 

 

 The Clip Information section on the General tab of the Clip Properties dialog displays the 

number of segments comprising the clip and the total running time for the clip. 

To modify the Clip Identifier and Clip Description 

1. Open the Clip Properties dialog for the desired clip. 

2. On the General tab, enter a new clip identifier in the Object Identifier field and modify the clip 

description. 

3. Click OK to save the changes or Exit to abandon the changes. 

 

Note: In order to save changes to the clip identifier, you must make a change to the 

clip description. 

 
Display Mode or Playback Mode Override 

You can modify the way a clip will display and play back when it is shown in Presentation Mode. You may 

change this option globally using the Presentation Preferences, but you may want to display and play back a 

particular clip in a different manner than the global setting. You can do this by setting the Display Mode 

Override and the Playback Mode Override properties for the clip. 

1. Open the Clip Properties dialog for the desired clip. 

2. On the Extended tab, use the drop-down menus to set the Override options. 
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3. Set the Display Mode Override: 

 Use Global Default uses the setting in Presentation Preferences. This is the default setting 

for all clips. 

 Display Video and Text shows both the video and the associated scrolling text 

 Display Text Only shows only the scrolling text 

 Display Video Only shows only the video 

4. Set the Playback Mode Override: 

 Use Global Defaults uses the settings in Presentation Preferences. This is the default 

setting for all clips. 

 Play at Start/Stop at End starts playing the video clip automatically without needing your 

intervention and closes the clip when it ends 

 Pause at Start/Pause at End pauses the video clip at the beginning, requiring you to start 

the video manually, and pauses the clip at the end, requiring you to close the video 

manually 

 Play at Start/Fade at End starts playing the video clip automatically without needing your 

intervention and fades the clip when it ends  

5. Click OK to save the changes or Exit to abandon the changes. 
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Opening and Closing Clips 

To open a clip 

1. Open an existing clip using one of the following methods: 

 Right-click on the clip in the Transcript Explorer and select Open from the shortcut menu  

-- OR -- 

 Select the Clip menu and select Open a Clip 

 

-- OR -- 

 Click on the Clip Editor tab and click on the Open button 

2. The Open a Clip dialog opens. You can sort by either Object ID (clip identifier) or Description by 

clicking on the appropriate column heading. By default, the clips are sorted by ObjectID. 

 

   

3. Select the clip you want to open and click Open or double-click on the clip identifier. To exit without 

opening a clip, click Cancel. 

To close the current clip 

Use any of the following techniques to close the current clip: 

 Select Close Clip from the Clips menu  

 Right-click on the Transcript window and select Close Clip from the shortcut menu  

 Right-click in the Clip Review section of the Clip Editor and select Close Clip from the shortcut 

menu  

 Open any other clip, which automatically closes the current clip. 
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Exporting a Clip Creation Script 

There may be occasions when you need to copy clips from one transcript or one case to another case. For 

example, if more than one person on the trial team is creating clips, use a Clip Creation Script (*.ccs) to 

replicate clips made by others into the master TrialDirector case. You may also modify a Clip Creation Script 

to string together multiple clips, although TrialDirector's Multiplayer Workbook gives you the same option 

without having to edit a script. 

A *.ccs file exported from TrialDirector will contain all of the clip description and identification information.  It 

will also contain the deponent information. 

To export the .css file 

1. In the Transcript Manager, select Clips in the View by dialog. 

2. Select the clips you want to include in the clip creation script. 

3. From the Clips menu, select Export Clip Creation Script (*.ccs). You may use the CTRL key to 

select multiple non-contiguous clips or the SHIFT key to select multiple contiguous clips. You can 

also select clips from different transcripts to export to the Clip Creation Script. 

 

Note:  The Export only the selected clip(s) option is unavailable if no clips are 

selected. 

4. Select Export All Clips or Export Only the Selected Clips and click Next to continue. 
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Note:  The script export path defaults to the TrialDirector case directory. 

5. Click Browse to select a new destination path for the clip creation script or leave the default 

destination path and click Next to continue. 

 

  

6. Click Export to begin exporting the clip creation script. 

7. When the progress bar reaches the end, click Next to continue. 
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. 

8. Review the export results carefully to ensure no warnings were issued. 

9. Click OK to exit the export wizard.
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Exporting Clips 

To share clips in your case with associates, opposing counsel or expert witnesses, use the TrialDirector's 

Export Clips function. During the export process, the file size is significantly reduced so the resulting video 

can be shared more easily. Exported clips can be e-mailed if they are small enough. They also can be 

exported to PowerPoint for presentation using that program.  

When you export clips, TrialDirector creates an MPEG file with optional embedded text captions. The text 

captions are comprised of the transcript text associated with the DVT clips. 

  

 

Tip: Use the Clip Editor to adjust the beginning and ending points of each clip segment before 

exporting the clips. Once the clips are exported, you cannot make adjustments. 

 

To export clips 

1. In Transcript Manager, select Clips in the View By drop-down menu. 

2. Choose the clips you want to export. You may use the CTRL key to select multiple non-contiguous 

segments or the SHIFT key to select multiple contiguous segments. 

3. Select the Export Clips option under the Clips menu.  

 

4. Select either Export All Clip(s) or Export Selected Clips option.  

5. Click Next to continue.   
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6. Select the destination for the excerpts: a Windows folder, an email recipient, or a PowerPoint 

presentation. 

7. Click Next. The next steps depend on which destination you selected. 

If you selected Send to Windows Folder: 

1. Specify the output settings for video or for audio-only and click Next. 
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Output Setting Description 

MPEG1 Ultra Compact 

(VBR)(email) 
Smallest file size, lowest resolution, good for e-mail 

attachments  

MPEG1 Compact (CBR) File size reduced from standard, some loss of resolution 

MPEG1 Standard (CBR) Standard MPEG digital compression 

MPEG1 VCD Compliant 

(VBR) 

Standard VCD compression (Video Compact Disc) 

MPEG2 Standard (VBR) Standard for digital compression of broadcast-quality video 

MPEG2 DVD Compliant 

(VBR) 

Standard for digital compression of broadcast-quality video 

(DVD) 

Automatic TrialDirector selects the best output setting based on several 

factors 

Note: If you are sharing the resulting clips with someone else, it may be preferable to select 

MPEG-1 as the output format rather than selecting Automatic. When Automatic is selected, 

TrialDirector chooses the best output based on several factors, but the recipient of the clip files may 

not have the correct software to play anything other than MPEG-1 format. 

2. Click Browse to select a path for the excerpt. If you want to include synchronized captions, be sure 

to select Output Synchronized Text Captions (*.smi). Click Next. 

 

 

3. Specify a transition effect and transition timing for the excerpt, if desired. Click Next. 
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4. Click Export to generate the excerpts.  

 

 
  

5. When the export process is complete, click OK to exit the wizard. 

Note: If the recipient intends to play the exported clips with captions in Windows Media Player, some 

settings must be made in Media Player in order for the captioning to appear. Refer to documentation for 

Windows Media Player for more information about these settings. 
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If you Selected Email Recipient: 

1. Specify a transition effect for the excerpts, if desired. Click Next. 

 

2. Click Export to export the clips.  

3. When the clips have been exported, click OK to exit the wizard. A blank e-mail message with the 

excerpt files attached will be opened on your screen. If the excerpts are large files, you may see the 

message below. 
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If you Selected PowerPoint Presentation: 

1. Click the Browse button to select a path and filename for the exported clips. Then specify the slide 

settings (layout and color).  

 

 

2. On the following screen, specify a transition effect for the excerpts, if desired. Click Next. 

 

3. Click Export to export the clips. When the clips have been exported, click OK to exit the wizard. A 

PowerPoint file containing the excerpts will be created on your computer at the location you 

selected in step 1. 
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Transcript Manager Options 

There are three categories of options for you to set in Transcript Manager: 

 General options 

 Highlight options 

 Clip options 

To access Transcript Manager Options 

1. Open Transcript Manager. 

2. Open the View menu and select Options. 

Once you have set the appropriate options in any of the three Options dialogs, click Apply or click Cancel to 

close the Options dialog. 

General Tab 

General Options Description 

Open last Case at 

start-up 

When you open TrialDirector, by default, the program opens 

displaying the last case worked on. If you deselect this option, when 

you open TrialDirector, a list of available TrialDirector cases appears 

allowing you to choose the case you want to open. 

Automatically Monitor 

Clipboard 

This option makes clipboard linking active by default when you open 

Transcript Manager. 

VCR Refresh This option determines how often the VCR display is refreshed. The 

default setting is 66 milliseconds. The lower the number of 

milliseconds, the more frequently the screen is refreshed. On 

computers with slower video cards, refreshing the VCR display 

frequently may result in a system performance loss. 

  

Options for 

Opening a Digital 

Video Transcript 

Description 

Display Organizer This option makes the Organizer Window visible by default. 

Show Word Index This option automatically displays the Word Index panel each time a 

transcript is opened. 

Synchronize Digital 

Video 

This option makes digital video synchronization active by default 

when you open a Digital Video Transcript. 

Synchronize Exhibits This option makes exhibit synchronization active by default when 

you open a Digital Video Transcript. 

Show 

Annotations/Issue 

Codes 

This option displays annotations or issue codes each time a 

transcript is opened. 
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Show Attached 

Exhibits 

This option displays attached exhibits when viewing a transcript. 

Show Multimedia 

Breaks 

This option makes "beginning of deposition" video markers visible by 

default when you open a Digital Video Transcript. 

  

Digital Video Transcript 

Properties 

Description 

Single Displays transcripts in single-spaced format 

1.5 Lines Displays transcripts in 1.5-spaced format 

Double Displays transcripts in double-spaced format 

Font Size Change the font size in which transcripts are displayed 

  

Highlight Tab 

The Highlight tab allows you to change the options for the highlight bar that moves through a Digital Video 

Transcript. 

  

Attributes Description 

Use custom Graphic This option allows you to browse and set a graphic for highlights. 

Use custom color 

scheme 

Use this option if you wish to designate distinct colors for the 

highlight bar and the transcript background. You may also choose 

whether to display the highlight with a border (default setting) if 

using a custom color scheme. 

Use Windows color 

scheme 

Use this option to properly display the transcript text and scrolling 

highlight bar under High Contrast display settings. Enable this option 

for users with accessibility needs. 

  

Size And Position Description 

Height This field allows you set the height of the highlight bar. Changing to a lower 

number makes the bar smaller. Changing to a higher number makes the bar 

bigger. 

Offset This field determines the position of the highlight bar from the top or bottom of 

the page and works only when the Alignment is set to Align Top or Align Bottom. 

An Offset of zero (0) and Alignment of Align Top places the highlight bar at the 

top of the page. 
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Alignment This field presents a drop-down list of three choices for the position of the 

highlight bar: Align Center, Align Top, and Align Bottom. It works in conjunction 

with the Offset to determine the location of the highlight bar on the transcript. 

  

Scrolling Description 

Speed The speed control determines how smoothly the highlight bar moves through the 

transcript. A value of 100 milliseconds would cause the highlight bar to jump, 

while a value of 500+ milliseconds would produce a smooth scroll. The default 

setting is 250 milliseconds. System performance is affected by increasing the 

number, so a compromise between performance and visual effects should be 

made. 

  

Clip Tab 

The Clip options tab allows you to set the multimedia clip options. 

  

Clip Creation Options Description 

Confirm identifier and 

description when 

creating a new Clip 

Selecting this option will prompt you to confirm the information is correct before 

saving a new clip. 

Use custom formatting 

for clip identifiers (within 

the current case) 

This option allows you to format custom clip identifiers using the codes shown 

below. For example: 

<FI><LI>-<MM><DD>-<SP5><SL2> 

Clips created with this format will be identified as: 

JS-12-05-00145:23 

The codes represent the following: 

<First Initial><Last Initial>-<Month><Day>-<5-digit zero-padded page 

number><two-digit zero-padded line number> 

  

Each case may have its own set of custom clip identifiers.  

  

Below is a list of codes to use for setting up custom identifiers: 

  

Separator for Formatting Custom Identifier  

- = Separator 

Name Formatting 

<FI> = First Initial 
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<LI> = Last Initial 

Date Formatting 

<MM> = Month 

<D> = Unpadded Day (ex. 5 or 12) 

<DD> = Padded Day (ex. 05 or 12) 

<M> = Unpadded month (ex. 2 or 11) 

<MM> = Padded Month (ex. 02 or 11) 

<YY> = Short Year (ex. 97 or 03) 

<YYYY> = Long Year (ex. 1997 or 2003) 

Starting Page Formatting 

<SP> = Unpadded start page (i.e., 1 or 15 or 273) 

(same as <SP0> or <SP1>) 

<SP1> = Padded to at least 1 digit (ex. 1 or 15 or 273) 

<SP2> = Padded to at least 2 digits (ex. 01 or 15 or 273) 

<SP3> = Padded to at least 3 digits (ex. 001 or 015 or 273) 

(up to SP9) 

<SP9> = Padded to 9 digits (ex. 000000001 or 000000015 or 000000273) 

Starting Line Number Formatting 

<SL> - Unpadded start line (i.e., 2 or 15)  

(same as <SL0> or <SL1>) 

<SL1> = Padded to at least 1 digit (ex. 2 or 15) 

<SL2> = Padded to 2 digits (ex. 02 or 15) 

Volume Number Formatting 

<V> = Unpadded Volume Number (ex. 1 or 24) 

<VV> = Padded Volume Number (ex. 01 or 24) 

  

Segment Creation 

Options 

Description 

Confirm before splitting 

Segments when manually 

creating Clips 

Enabling this option prompts you prior to splitting transcript selections into 

multiple segments during manual clip creation. Segment splits only occur when 

the transcript contains objections, multimedia breaks or periods of silent. If this 

option is disabled, the segment is automatically split without user notification. 

(Enabled by default.) 

Split Segments at 

multimedia breaks 

This option splits a transcript text selection that spans across multimedia breaks 

and creates two separate segments. (Enabled by default.) 

Split Segments to 

exclude objections 

This option splits a transcript text selection that contains objections and creates 

two separate segments. (Enabled by default.) 

Split Segments to 

exclude silence over <set 

This option splits a transcript text selection that contains long periods of silence 

and creates two separate segments. (Enabled by default and set to 10 seconds.) 
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amount of> seconds 

Adjust start by This option sets the number of seconds by which the start time is adjusted when 

a segment is created. 

Adjust end by This option sets the number of seconds by which the end time is adjusted when 

a segment is created. 

  

Editing and Review 

Options 

Description 

Automatically play Clips 

and Segments after 

drag/drop 

This option causes segments and clips to be played automatically when they are 

dragged and dropped into the Transcript Window. (Enabled by default.) 

Display Segment breaks 

in Segment Editor 

This option causes segment breaks to be displayed between the corresponding 

transcript text for each segment when a clip is loaded in the Segment Editor. 

(Enabled by default.) 

Adjust segment seek to 

start by 

This option sets the number of seconds before or after the segment start time to 

which the multimedia jumps when you seek to the start of a segment. Default: -3 

seconds 

For example, if the segment seek to start adjustment is set to 2 seconds, and 

you seek to the start of a segment that begins at 00:00:03:00, the multimedia will 

automatically jump to 00:00:01:00. 

Adjust segment seek to 

end by 

This option sets the number of seconds before or after the segment end time to 

which the multimedia jumps when you seek to the end of a segment. Default: -3 

seconds 

For example, if the segment seek to end adjustment is set to 2 seconds, and you 

seek to the end of a segment that ends at 00:00:45:00, the multimedia will 

automatically jump to 00:00:47:00. 

Note:  If your Digital Video Transcript timestamps are precise, both of the Automatically adjust segment 
time settings can be set to 0.  This would minimize the need for clip editing. 
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Playing a Clip 

When you play a clip in the Transcript Manager, the video appears in the Multimedia Player (in the right panel 

of the Transcript Manager desktop) and, if the Transcript tab is active, the text of the transcript follows along 

with the video. If the Clip Editor is active, the text of the clip appears in the Review Clip Text section of the 

Clip Editor. 

To play a clip 

1. Expand the transcript folder by clicking on the + sign to the left of the folder or double-click on the 

transcript identifier. 

2. Expand the desired clip folder and right-click on the full clip icon. Select Play on the shortcut menu 

or select Play Clip on the Clips menu. In the Clip Editor, click on the Play the Full Clip button 
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Presenting Digital Video Transcripts (DVTs) 

When you load a DVT on to the Presentation display, the control bar appears collapsed beneath it: 

 

Click on it to expand the full controls: 

 

Controlling the DVT 

 To keep the jury from seeing the control bar, detach the exhibit controls and move them to your 

control display, and/or use Mirror Mode to control your presentation from behind the scenes. Test 

these options first to determine what works best for you. 

 When you load a DVT in Presentation mode, TrialDirector will either begin playing it immediately or 

wait for you to click the Play button, depending on the default preference selected (see Presentation 

Preferences > Exhibits > Digital Video Transcripts > DVT Play Options) and whether you set an 

override in the clip properties. You can also set options to control whether DVTs automatically close 

when they finish playing, or remain open and paused. 

 To toggle between pause and play, double-click anywhere on the video. 

 To automatically move to a particular point in the synchronized video, double-click a line in the 

transcript text. Then double-click on the video (or press the Play button) to begin playback from that 

point. 

 When you use the controls to move to different points in the video, the transcript text is automatically 

repositioned when the video resumes playing. 

Displaying the Full DVT (Virtual Clip) 

 Transcript Manager automatically creates a virtual clip for each DVT that enables you to play the 

entire DVT in Presentation mode. It appears as "Virtual Clip (ID)" in Transcript Explorer under the 

deponent's name. 

Example  
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 To display the transcript only (no video), type the Clip ID followed by :T and press ENTER. Using the 

example above, you would type: 

MP-0721:T 

After the transcript appears, you can type -pg## and press ENTER to go to a specific page in the 

transcript. To go to page 3, you would type: 

-pg03 

Setting the Layout of the Video and Transcript 

 The options in Presentation Preferences > Exhibits > Digital Video Transcripts give you control over 

the default layout of the video and transcript text, how text is highlighted, fonts, and more. Spend 

some time experimenting with these settings, and expand the Information text in Presentation 

Preferences for more information. 

 You can move DVTs around the Presentation display the same way you move images (see 

Controlling the Presentation Display ). 

 To change the layout position of the video and transcript on-the-fly during presentation, hold CTRL 

and press TAB repeatedly to move through the available layouts in the popup box. When the correct 

layout is selected, release both keys. 

Viewing Attached Exhibits 

 If you've attached exhibits to a transcript in Transcript Manager, each exhibit automatically appears 

at the right time when you present the DVT. 

 You can specify whether attached exhibits open in Zone 1 (to the left of the DVT) or Zone 2 (to the 

right of the DVT) in Presentation Preferences > Exhibits > Digital Video Transcripts > Linked Exhibits. 

 You can annotate the exhibit just as if you loaded it yourself, though you may want to pause the DVT 

while you do so. 

 Provided you specified when to clear the attached exhibit in Transcript Manager, it will close at the 

appropriate time. However, you can also hover over the top right corner to access the controls that 

enable you to close it, maximize it, or move it to a different zone. (See Controlling the Presentation 

Display  for more information.) 
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Annotating and Emphasizing the DVT 

 You can use tools on the Presentation Toolbar to annotate and emphasize aspects of a running 

video and the transcript text. 

 Consider using Callout Zoom tools , such as Projection Zoom  or Capsule Projection 

to draw the jury's attention to the deponent's face. 

Enabling Closed Captions 

To enable closed captioning on-the-fly during presentation, type -CC and press ENTER. (Repeat this 

command to disable closed captioning.) To select an alternate layout of the video and transcript text, hold 

CTRL and press TAB repeatedly to move through the available layouts in the popup box. When the correct 

layout is selected, release both keys. 
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Using TimeCoder 
Timecoding a transcript is synchronizing the ASCII transcript to the multimedia file by setting time stamps on 

each line of the transcript. This allows synchronized playback of video files and an accompanying transcript. 

TrialDirector includes a simple timecoding tool (TimeCoder) which is very effective for small jobs. If you will be 

performing a large amount of timecoding, we recommend that you obtain a copy of inData's TimeCoder Pro. 

Timecoder Pro automates the process of timecoding, as well as performing the synchronization as much as 

20 times faster than realtime. 

Note: Before beginning the timecoding process, ensure that the appropriate DVT has been created 

and that at least one of the corresponding multimedia files has been loaded. 

Timecoding a Transcript 

To begin timecoding a transcript: 

1. From the Tools menu, select Timecoder.... The following windows appear: 

 

http://www.indatacorp.com/Products/Video/timeCoderPro.aspx
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2. In the Open a Digital Video Transcript window, select the appropriate multimedia file from the 

Multimedia Selection Box. If there are no multimedia files to choose from, load the appropriate 

multimedia files.  

 

3. Find the place in the transcript where the selected multimedia file begins. To do this, click Play  

on the Multimedia Control Box, listen to the first few words of the multimedia file and then search for 

those words in the ASCII transcript using the Find command under the Edit menu. 

Note: If you cannot locate the first words of the multimedia file, advance the multimedia file and 
try again since the transcription may begin further into the multimedia file. 

4. When you have found the beginning of the multimedia file in the transcript, verify that the blue 

highlighter bar is on the line of transcript that corresponds to the beginning of the multimedia file. 

Click the Seek to Start button  on the Multimedia Control Box to rewind the multimedia file to 

the beginning. 

5. Click Record   on the Multimedia Control Box to enter Timecoding Mode. 

6. Click Play on the Multimedia Control Box to begin playback of the multimedia file. 
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7. When the multimedia file reaches the first word of the transcript line that is currently highlighted in 

blue, press the SPACEBAR. The current multimedia time is stamped on the left side of the transcript 

line, as shown below. 

 

8. Continue this process until you reach the end of the multimedia file. If you miss a line or stamp a line 

incorrectly, use the appropriate keyboard commands to edit your mistakes (see Editing Timecodes 

below). 

Note: You must be in Timecoding Mode to edit timecodes.  To enable Timecoding Mode, click the 
Record button so that it is red. 

9. If there are additional multimedia files, repeat steps 2 through 8 until the entire transcript has been 

timecoded. When the entire transcript has been timecoded, you can export the Digital Video 

Transcript. 
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Editing Timecodes 

The sections below explain how to correct the two most common errors made while timecoding a transcript. 

You must be in Timecoding Mode in order to edit timecodes. To enable Timecoding Mode, click the Record 

button so that it is red. 

Note: When editing timecodes, ensure that the timecodes are in chronological order. For example, the 
timecode 00:00:15 cannot be preceded by 00:00:30. 

Timecoding a Missed Line 

If you do not press the spacebar in time to place a timecode on a line of transcript, simply rewind the 

multimedia file by pressing the LEFT ARROW key on your keyboard. When the multimedia file reaches the 

appropriate position again, press the SPACEBAR and continue timecoding as you normally would. 

 
Changing an Incorrect Timecode  

If you press the SPACEBAR at the incorrect time or on the incorrect line, pause the multimedia file by clicking 

Pause   or by selecting Pause from the Multimedia menu. Then use the UP ARROW or DOWN ARROW 

on your keyboard to move the highlighter to the line with the incorrect timecode. Press the DELETE key on 

your keyboard to erase the timecode. Rewind or advance the multimedia file as necessary and click Play or 

select Play from the Multimedia menu. When the multimedia file reaches the appropriate position again, 

press the SPACEBAR and continue timecoding as you normally would. 

Note: If you are in Timecoding Mode and the highlight bar is on a line that already has a timecode, 

pressing the SPACEBAR will overwrite the old timecode with a new timecode that corresponds to the 

current time in the Multimedia Control Box. 
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Creating a Digital Video Transcript (DVT) 

Using TimeCoder, during the DVT creation process, the deposition transcript is added to the DVT database. 

You can also process the associated Audio/Video reference files along with a pre-timecoded transcript. 

1. To create a new DVT, select the Tools menu and choose TimeCoder. 

2. In TimeCoder, select Create a New Digital Video Transcript from the File menu. The following 

dialog will appear: 

 

3. Click Browse to select the deposition transcript you wish to use. Click Next to continue. 

 

4. Enter the deponent information as shown in the screen above. You can use the 'Other' field to 

include other case or deposition information or to enter a description for a proceeding other than a 

deposition, i.e., a trial or hearing transcript. Click Edit if you wish to view the actual transcript text file. 

Click Next to continue.  
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5. Confirm the page and line information for the transcript text file. Click Edit if you wish to view the 

actual transcript text file. Click Next to continue. The following screen will appear:  

 

6. You have the option to preserve the original timecodes within a deposition transcript, if they exist. 

Click here to view the steps involved to preserve timecodes. If you wish to import the transcript 

without timecodes, click Next to continue. 

7. Click Create to begin the DVT creation process. 

 



TrialDirector 6 Help - Preparing Transcripts  

88 Copyright ©2011 inData Corporation. All Rights Reserved. 

8. After the process is completed, click Next to continue. After the DVT has been created, the screen 

below is displayed so you can review the creation results. 

 

9. Click OK to open the newly created DVT or click Again to create another DVT. 
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Importing Transcripts 

Topics: 

 Import TrialDirector™ Case File (*.cms) 

 Import LiveNote™ / VideoNote™ File (*.ptf, *.vid) 

 Import RealLegal™ E*Transcript™ Files (*.ptx) 

 Import Sanction II™ Transcript Database (*.mdb) 

 Import Timaro™ Post-production Time Stamp File (*.pts) 

 Import TrialPro™ Post-production Time Stamp File (*.pts) 

 Import YesEdit™ CD-ROM with Sanction™ Transcript Database (*.mdb) 

After a transcript has been synchronized using either the TimeCoder application or a third 

party program, it can then be imported back into TimeCoder. 

The TimeCoder import features are especially useful for converting one timestamp file 

format to another.  For example, a Sanction II™ transcript database (*.mdb) can be 

converted to a TrialDirector Case File (*.cms) via the TimeCoder import/export features. 
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Importing a TrialDirector Case File 

TimeCoder can import existing *.cms files that may have been created in previous versions 

of TimeCoder, TrialDirector or DVTWizard.  TimeCoder users may want to import legacy 

*.cms files to correct timecodes, add/remove multimedia resource files, adjust timecodes 

etc.  After the *.cms file is imported into TimeCoder, it can even be exported to other 

formats. 

When a synchronized transcript is contained within a TrialDirector Case, we will need to 

import the corresponding *.cms file. 

Follow these steps to import from a TrialDirector Case: 

1. Select Import from... | TrialDirector™ Case file (*.cms) from the File menu. 

 

2. Enter a destination path and filename for the *cms file, or click Browse to navigate 

to the desired path and filename. 

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and *.cms file. Click Open. 
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3. When the desired path and filename are selected, click Next. The following window 

appears: 

 

4. Select the Digital Video Transcript(s) you would like to import into the current case. 

Click Select All to import all Digital Video Transcripts or Clear All to clear all 

selections. Click Next to continue. 

 

5. Click Import to continue the import process. 
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6. Verify that there are no warnings that were issued. Then select OK to complete the 

import process. You will then need to open the Digital Video Transcript that you 

imported. 
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Importing LiveNote / VideoNote Files 

When a synchronized transcript is imported from a LiveNote™ / VideoNote™ file, you will 

need to import the *.ptf / *.vid files that were created from the original application. 

To import files from LiveNote / VideoNote: 

1. Select  from the File menu. 

 

2. Enter a destination path and filename for the *.PTF file, or click Browse to navigate to the desired 

folder and filename. 

Note: If the *.PTF and *.VID files reside in the same directory, selecting the *.PTF will select the 
associated *.VID file, as well. 

a. If you click Browse the following window appears: 

 

b. Select the desired destination folder and *.PTF file and click Open. 

3. When the desired folder and filename are selected, click Next. 



TrialDirector 6 Help - Preparing Transcripts  

94 Copyright ©2011 inData Corporation. All Rights Reserved. 

 

4. Enter the information for the deponent. 

First Name  

Middle Initial  

Last Name  

Suffix  

Date Deposition date 

Volume # Deposition volume number 

Other Additional information 

The Deposition Information and Other Information can be enabled or disabled by checking or 

removing the checkmark from their respective boxes; however, both cannot be disabled at the same 

time. If you choose to enable the Deposition Information, the FIRST, LAST, DATE and VOLUME # 

fields must be filled in. If you choose to enable the Other Information, the OTHER field must be filled 

in. 

5. When you are finished entering information into the fields, click Next. 
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6. If the first page of the transcript that contains line numbers is a page other than one, enter the 

correct page number or use the small arrow buttons to select the correct page number. 

7. Click Next to continue. 

 

8. 

associated with the VideoNote (*.vid) file in chronological order. Click here for instructions on 

preserving timecodes. 

9. Click Next to continue. 
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10. Click Create to begin the import process. When the progress bar reaches the end, the import is 

complete. 

 

11. Review the import results carefully to ensure that no errors were encountered. 

12. Then select OK to complete the import process. 
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Importing RealLegalE*Transcript Files 

When a syn

the .ptx file that was created in the original application. 

To import files from RealLegal: 

1. Select  from the File menu. 

 

2. Enter a destination folder and filename for the *.PTX file, or click Browse to navigate to the desired 

folder and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and .PTX file and click [OPEN]. 

Note:  TimeCoder Pro can import either the .PTX or .EXE format of E*Transcript files.  

3. When the desired folder and filename are selected, click Next. 

4. If the selected .PTX/.EXE file requires a password, the following dialog will be displayed. 
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5. Enter the required password and click Next to continue.  The password is generated by the 

authoring entity of the E*Transcript file.  If the password cannot be obtained, the file cannot be 

imported.  You will have to contact the author of the E*Transcript file to obtain the password. 

 

6. Enter the information for the deponent. 

First Name  

Middle Initial  

Last Name   

Suffix  

Date Deposition date 

Volume # Deposition volume number 
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Other  Additional information 

7. The Deposition Information and Other Information can be enabled or disabled by checking or 

removing the checkmark from their respective boxes; however, both cannot be disabled at the same 

time. If you choose to enable the Deposition Information, the FIRST, LAST, DATE and VOLUME # 

fields must be filled in. If you choose to enable the Other Information, the OTHER field must be filled 

in. 

8. When you are finished entering information into the fields, click Next. 

 

9. If the first page of the transcript that contains line numbers is a page other than one, enter the 

correct page number or use the small arrow buttons to select the correct page number. 

10. Click Next to continue. 

 

11. This window indicates that you are ready to import the DVT. Click Create to begin the import 

process. 
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12. Review the import results carefully to ensure that no errors were encountered. 

13. Select OK to complete the import process.
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Importing a Sanction II Transcript Database 

When a synchronized transcript database is created within the Sanction II™ application, the 

corresponding *.mdb file can be imported into Timecoder. 

To import from a Sanction II™ Transcript Database file 

1. Select Import from... | Sanction II Transcript Database (*.mdb) from the File 

menu. 

 

2. Enter a destination path and filename for the *mdb file, or click Browse to navigate 

to the desired path and filename. 

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and *.mdb file. Click Open. 
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3. When the desired path and filename are selected, click Next. The following window 

appears: 

 

4. Enter the information for the deponent. 

The following fields are available: 

Field Description 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Surname Deponent’s surname 

Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the First, Last, Date and Volume # fields must be filled in. If you choose 

to enable the Other Information, the Other field must be filled in. 

5. When you are finished entering information into the fields, click Next. 
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6. If the first page of the transcript that contains line numbers is a page other than one, enter the 

correct page number or use the small arrow buttons to select the correct page number. 

7. Click Next to continue. 

8. Once all adjustments are made, if necessary, select Next to continue. The following 

window will appear. 

 

This window will allow you to preserve timecodes which may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. 
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7. If you choose not to preserve original printed timecodes, select Next to continue. 

The following window will appear: 

 

8. Click Create to begin the creation process. The following window appears: 

 

9. Review the import results carefully to ensure that no errors were encountered, then select OK to 

complete the import process. 
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Importing Timaro Post-production Time Stamp Files 

-production Timestamp file, you will 

need to import the *.pts file that was created in the original application. 

1. Select Import from... | Timaro Post-production Time Stamp File (*.pts) from 

the File menu. 

 

2. Enter a destination path and filename for the *.pts file, or click Browse to navigate to the desired 

path and filename. 

        a.  If you click Browse, the following window appears: 

 

b.  Select the desired destination folder and *.pts file,  Click Open. 
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3. Once the desired path and filename are selected, click Next.  The following window appears: 

 

4. Enter the information for the deponent. The following fields are available: 

 

Field Description 

First Name Deponent’s first name 

Middle 

Initial 
Deponent’s middle initial 

Last 

Name     
Deponent’s last name 

Suffix        Suffix added to Deponents name, such as Jr., Sr., Esq. 

Date Deposition date 

Volume 

#      
Deposition volume number 

Other    Additional information 

The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. 

If you choose to enable the Deposition Information, the First, Last, Date and Volume 

# fields must be filled in.  If you choose to enable the Other Information, the Other 

field must be filled in 

5. When you are finished entering information into the fields, click Next.  
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6. If the first page of the transcript that contains line numbers is a page other than one, enter the 

correct page number or use the small arrow buttons to select the correct page number. 

7. Click Next to continue. 

 

This window will allow you to preserve the original timecodes within the Post 

Production Timestamp (*.pts) file.  If you want to preserve timecodes, you must 

specify all audio/video resource(s) associated with the .PTS file in chronological 

order.  Click here for instructions on preserving timecodes. 

8. Click Next to continue. 
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9. If you choose not to preserve original printed timecodes, select Next to continue.  The following 

window will appear: 

 

10. Click Create to finish the creation process.  The following window appears: 

 

11. Review the export results to ensure that the operation was completed successfully. Click OK to exit 

the export process. 
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Importing TrialPro Post-production Time Stamp Files 

When a synchronized transcript is imported from a TrialPro™ Post-production Timestamp 

file, you will need to import the *.pts file that was created in the original application. 

1. Select Import from... | TrialPro Post-production Time Stamp File (*.pts) from 

the File menu. 

 

2. Enter a destination path and filename for the *.pts file, or click Browse to navigate to the desired 

path and filename. 

        a.  If you click Browse, the following window appears: 

 

b.  Select the desired destination folder and *.pts file,  Click Open. 
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3. Once the desired path and filename are selected, click Next.  The following window appears: 

 

4. Enter the information for the deponent. The following fields are available: 

 

Field Description 

First Name Deponent’s first name 

Middle 

Initial 
Deponent’s middle initial 

Last 

Name     
Deponent’s last name 

Suffix        Suffix added to Deponents name, such as Jr., Sr., Esq. 

Date Deposition date 

Volume 

#      
Deposition volume number 

Other    Additional information 

The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. 

If you choose to enable the Deposition Information, the First, Last, Date and Volume 

# fields must be filled in.  If you choose to enable the Other Information, the Other 

field must be filled in 

5. When you are finished entering information into the fields, click Next.  
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6. If the first page of the transcript that contains line numbers is a page other than one, enter the 

correct page number or use the small arrow buttons to select the correct page number. 

7. Click Next to continue. 

 

This window will allow you to preserve the original timecodes within the Post 

Production Timestamp (*.pts) file.  If you want to preserve timecodes, you must 

specify all audio/video resource(s) associated with the .PTS file in chronological 

order.  Click here for instructions on preserving timecodes. 

8. Click Next to continue. 
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9. If you choose not to preserve original printed timecodes, select Next to continue.  The following 

window will appear: 

 

10. Click Create to finish the creation process.  The following window appears: 

 

11. Review the export results to ensure that the operation was completed successfully. Click OK to exit 

the export process. 
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Importing a YesEdit CD-ROM with Sanction II Transcript Database 

When a synchronized transcript database is created on YesEdit™ CD-ROM with Sanction™ II 

Transcript Database application, the corresponding *.mdb file can be imported into 

TimeCoder. 

To import from a YesEdit™ CD-ROM with  Sanction II™ Transcript Database file 

1. Select Import from... | YesEdit™ CD-ROM with Sanction™ II Transcript 

Database (*.mdb) from the File menu. 

 

2. Enter a destination path and filename for the *mdb file, or click Browse to navigate 

to the desired path and filename. 

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and *.mdb file. Click Open. 
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3. When the desired path and filename are selected, click Next. The following window 

appears: 

 

4. Enter the information for the deponent. 

The following fields are available: 

Field Description 

First Name Deponent’s first name 

Middle Initial Deponent’s middle initial 

Last Name  Deponent’s last name 

Surname Deponent’s surname 

Date Deposition date 

Volume # Deposition volume number 

Other  Additional information 

The Deposition Information and Other Information can be enabled or disabled by 

checking or removing the checkmark from their respective boxes; however, both 

cannot be disabled at the same time. If you choose to enable the Deposition 

Information, the First, Last, Date and Volume # fields must be filled in. If you choose 

to enable the Other Information, the Other field must be filled in. 

5. When you are finished entering information into the fields, click Next. 
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6. If the first page of the transcript that contains line numbers is a page other than one, enter the 

correct page number or use the small arrow buttons to select the correct page number. 

7. Click Next to continue. 

8. Once all adjustments are made, if necessary, select Next to continue. The following 

window will appear. 

 

This window will allow you to preserve timecodes which may appear in the original 

printed transcript. If you want to preserve timecodes, you must specify all 

audio/video resource(s) for this Digital Video Transcript in chronological order. Click 

here for instructions on preserving timecodes. 
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7. If you choose not to preserve original printed timecodes, select Next to continue. 

The following window will appear: 

 

8. Click Create to begin the creation process. The following window appears: 

 

9. Review the import results carefully to ensure that no errors were encountered, then select OK to 

complete the import process. 
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Using Multimeda Manager 

After you create a new Digital Video Transcript (DVT), you need to add one or more audio/video files using 

the Multimedia Manager. If you have multiple audio/video files that accompany a transcript, use the 

Multimedia Manager to organize the files before you synchronize (timecode) the transcript with them.  

Opening the Multimedia Manager 

On the Multimedia menu, click Multimedia Manager. 

 

Note to version 5 Users: Use the Add Files and Up/Down buttons to add and organize your 

files just as you did in the former Multimedia Stream Manager. The new buttons offer advanced 

organization capabilities, but are not required. 
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Adding Individual Files (such as MPEG, AVI, or WMV) 

1. Click Add Files to select one or more multimedia resource files to add to the DVT. 

2. Browse to the location of the multimedia file(s) and select. To select more than one file, press and 

hold CTRL. 

3. Click Open. 

4. The file(s) appear in the Multimedia Manager. If they are not in chronological order, use the Up and 

Down buttons to adjust the position of the multimedia resources as necessary. 

The files must be in order to ensure accuracy when the transcript is synchronized (timecoded) with 

the multimedia files. 

 

The path of each multimedia resource file is used in the *.cms file exported from 
TimeCoder Pro. Once the *.cms file is loaded into TrialDirector, the user may have to 

browse to the multimedia file location if the path is different. 

5. If you are finished adding and organizing multimedia files, click OK to return to the transcript. 

Adding a DVD-Video or Video CD 

Use the Add DVD button whenever you are loading files from a DVD or VCD, or when the contents of the 

DVD/VCD has been copied to a folder on a local or network drive. 

 

Note: Super Video CDs (SVCDs) are not supported. 

1. Click Add DVD. 

2. If the disc is currently mounted in a drive, browse to and select the drive letter. 

-or- 

If the disc contents has been copied on to a local or network drive, browse to and select the root 

folder of the DVD/VCD contents. 

3. Click OK. 

The inData Digital Video Disc (DVD) Extractor automatically opens. 

4. Use the inData Digital Video Disc (DVD) Extractor to convert the video to an MPEG-2 stream. Then, 

select the .MPG file and click Open. 

5. Repeat the previous steps for any additional DVDs/VCDs. 
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Grouping Files for Export (Advanced Users) 

If you will be exporting a synchronized transcript and multimedia files across multiple CDs/DVDs, you can 

use groups to designate which files should go on which discs. 

1. In the Multimedia Manager, click the New Group button. 

A folder named Untitled Multimedia Group appears. 

2. Click once on the folder name to select it. Then, click again to insert the cursor on the text. Type a 

meaningful name for the group (for example, the deponent's initials, deposition date, and the disc 

number: SK110907 Disc1). 

3. Repeat the previous steps to create groups for ..Disc2, ..Disc3, etc. as needed. 

4. Select a file and click the Up/Down buttons as needed to move it to the appropriate location under 

the appropriate group. Repeat for each file. Ensure all files are in chronological order on each 

disc. 

 

The following example shows the structure for a deposition expected to span three discs when it is 

exported: 
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5. When you are finished organizing files in groups, click OK. 

You can return to the Multimedia Manager at any time before you export the synchronized transcript 

and multimedia files to CDs/DVDs to reorganize or replace them as needed. 
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Preserving VideoNote Transcript Timecodes 

To preserve the existing VideoNote™ timestamps during import 

1. Check the  option, as shown below. 

 

2. Click Add to specify one or more audio/video resources that correspond with the original VideoNote 

(*.vid) file.  

 

3. Select the audio/video file(s) and click Open to add the selection(s) to the list.  

4. Repeat the process until all audio/video reference files have been added to the list. 
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5. If the multimedia resource files are not in chronological order, use the Up or Down buttons to adjust 

the position of the multimedia resources as necessary. 

6. When all of the audio/video reference files have been added, click Next to continue. 



TrialDirector 6 Help  Preparing Transcripts 

 Copyright ©2011 inData Corporation. All Rights Reserved. 123 

Preserving Existing Transcript Timecodes 

Important Information About Transcript Timecodes 

During the Digital Video Transcript (DVT) creation process, users are given the option to preserve timecodes. 

This option is designed to preserve existing timecodes within the deposition transcript used during the DVT 

creation process. Timecodes are usually generated in a transcript by the court reporter using "real-time" 

steno software. 

Below are some requirements of a transcript when preserving timecodes: 

 Timecodes must exist on the left margin. 

 Timecodes must be in SMPTE format (HH:MM:SS). An example of this format is 01:23:10. 

 Timecodes must not exceed 24 hours in duration. 

Note: Timecodes may be in a linear format or time of day format, as long as they adhere to the SMPTE 
format. 

Preserving Transcript Timecodes During DVT Creation Process 

Preserving timecodes is a multi-step process. Follow the steps below to preserve timecodes. 

1. During the DVT creation process, the dialog below appears allowing one to preserve timecodes 

within the deposition transcript if desired. Check the "Preserve original printed timecodes" option, as 

shown below. 

 

2. Optionally, you can deselect the "Adjust first timecode to 00:00:00" option. This option will readjust 

timecodes to offset at 00:00:00 in order to list the timecodes in a linear fashion. If you wish to 

maintain timecodes in their original state (ex. time of day), you can uncheck this option. For best 

results, we recommend leaving this option checked. 

3. Next, the associated audio/video resource(s) for the Digital Video Transcript must be added in 

chronological order. This process will determine the running time(s) of the audio/video resource(s), 
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then match those resources against the timecodes within the deposition transcript. Click Add to 

begin adding the audio/video resources. The following window will appear: 

 

4. Browse to the location of the first audio/resource file and select Open to add to the list. Repeat the 

process for any other additional audio/video reference files. When completed, the audio/video 

reference files will appear in the list as depicted below. 

 

5. Click Next to continue through the process. After the DVT has been created, the timecodes will 

appear within the deposition transcript. Also, the associated audio/video reference files are available 

to review. 

6. Check the synchronization of the DVT by playing back each of the associated audio/video 

references. Slide the seek bar (on the Multimedia Control Box) to various places within the reference 

file to make sure the playback is in synchronization with the timecoded transcript. You may have to 

adjust timecodes as necessary. After you have checked the DVT for proper synchronization, it can 

be exported. 
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Using Q/C TimeCodes 

TimeCoder Q/C feature that allows the user to quickly review and update timecodes after 

timecoding. The Q/C feature will clearly mark, in red, each line that does not contain a 

timecode. Below are the steps to effectively Q/C timecodes. 

Topics 

 Enable Q/C Mode 
 Q/C Mode Display 
 Navigate Between Missing Timecodes 
 Mark Missing Timecodes 
 Using Extrapolate Timecodes Function 

Note:  Normally, only transcript pages containing Question and Answer dialogue are 

included in the Q/C range.  Transcript title pages and certification pages are not included 

when verifying timecoded lines. 

Enable Q/C Mode 

1. First open the Digital Video Transcript you wish to check.  

2. Click the   button on the TimeCoder toolbar.  Alternatively, select the Enable 

Quality Control (QC) Mode from the Edit menu. 

Q/C Mode Display 

When the TimeCoder Q/C mode is enabled, any transcript dialogue lines that do not have an 

associated timecode are marked in red.  
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Note: The light blue colored line indicates the current position within the Digital Video 

Transcript. 

Navigate Between Missing Timecodes 

When the transcript lines missing timecodes have been identified, the user can then 

navigate between each instance to manually timestamp that particular line.  There are 2 

methods for navigating between missing timecodes. 

 Click the Move to Previous Missing Timecode   and Move to Next Missing 

Timecode   buttons  on the TimeCoder Pro toolbar. 

 Alternatively, use the [N] and [B] keys to move to the Next Missing Timecode and 
Back Missing Timecode.  These keys are used because of their close proximity to the 
[Spacebar].  

Mark Missing Timecodes 

 Begin playback of the Digital Video Transcript by clicking the [Play] button on the 

VCR Control. 

 Enable Timecoding mode by clicking the record button   within the VCR 

Controls. This button will turn red when the Timecoding mode is enabled. 

 Use either the  button or [N] key to move to the next missing 

timecode.  Playback will commence from the timestamp located directly above the 
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marked (red) line.  This will give the Q/C operator ample time to mark the 

timestamp for the red line. 

 Press the [Spacebar] to timestamp the red line.  The [Spacebar] should be 

pressed at the first spoken word of the marked (red) line. 

 The red line will turn to blue and the playback will continue., as shown below. 

 

 Move the next missing timecode by pressing the [N] key again, as shown 

below.  Use the [Spacebar] to timestamp the line. 
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 Repeat the process until all of the marked (red) lines have been timestamped. 

Note: The grey colored line indicates a non-spoken portion of the Digital Video 

Transcript.  The transcript title, appearances, and certification areas will usually be marked 

as a grey line.  These areas are automatically defined during import of the source transcript 

and do not need to be timecoded. 

Using Extrapolate Timecodes Function 

TimeCoder has an Extrapolate Timecodes function that will automatically "fill" gaps between 

timecoded lines.  This feature is handy for automatically populating missing 

timecodes.  However, this feature should only be used when there are 1-2 line gaps 

between timecodes.  Attempting to extrapolate a Digital Video Transcript with large blocks 

of un-timestamped lines will result in poor synchronization during playback. 
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Exporting Transcripts 

After a DVT has been synchronized by timecoding the transcript, it can be exported to a 

number of formats.  Click the links below to learn more about each export format. 

Topics: 

  

 le (*.xml) 

  

 Export Transcript to ASCII Format(*.txt) 

 Export Transcript to AMICUS Format(*.ami, *.trn) 

  

 Export to Media Player Synchronized Media File (*.smi) 

  

  file (*.sbf) 

 Export to a Timaro Post-Production Timestamp File (*.pts) 

 Export to a TrialPro Post-Production Timestamp File (*.pts) 
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Exporting to TrialDirector Case File 

When a synchronized DVT is exported to a TrialDirector Case File, a Compound Media Storage (*.cms) file is 

created, which can be imported into TrialDirector. 

To export a TrialDirector Case File 

1. Open the DVT you want to export. 

2. Select Export to... | TrialDirector(TM) Case file (*.cms) from the File menu. The following window 

appears: 

 

Note: At any time during the export, you may click Back to return to the previous export window or 
Cancel to cancel the export. 

3. Enter a destination folder and filename for the *.cms, or click Browse to navigate to the desired 

folder and filename. 

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.cms file in the File Name 

field. Click Save to save the selection. 

4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the DVT. When the progress bar reaches the end, the export is 

complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. Click OK to exit the 

export process. 



TrialDirector 6 Help - Preparing Transcripts  

132 Copyright ©2011 inData Corporation. All Rights Reserved. 

Exporting to an OpenDVT XML File 

The OpenDVT XML file is an open file format for Digital Video Transcripts.  This format was 

developed by inData, in conjunction with other software vendors, to provide a mechanism 

for the seamless exchange of transcripts & synchronization information between 

applications. 

To export to an OpenDVT XML file 

1. Open the timecoded DVT. 

2. Select Export To... | OpenDVT(TM) XML File (*.xml) from the File menu.  

 

3. Enter a destination path and filename for the *.xml file, or click Browse to navigate 
to the desired path and filename. 

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.xml file in the File 
Name field.  Click Save to save the selection. 
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4. When the desired path and filename are selected, click NEXT.     

 

5. Click Export to begin exporting the OpenDVT XML file.  When the progress bar reaches the end, the 

export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered.  Click 

OK to exit the export process. 
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Exporting to TimeCoder Multimedia List File 

The TimeCoder Multimedia List file is a comma-delimited text file that details information 

about each Multimedia Resource file that is part of the Digital Video Transcript.  Exporting 

the TimeCoder Multimedia List file is a handy way to backup information about the 

multimedia files associated with a timecoded transcript.  

The TimeCoder Multimedia List file can be used in place of the audio/video files when 

preserving transcript timecodes during the DVT creation process.  

The TimeCoder Multimedia List file can be used by 3rd party applications (along with a 

timecoded transcript) that need to import data from TimeCoder. 

To export a TimeCoder Multimedia List file 

1. Open the timecoded DVT. 

2. Select Export To... | TimeCoder Multimedia List (*.tml) from the File menu.  

 

3. Enter a destination path and filename for the .TML file, or click Browse to navigate 
to the desired path and filename. 
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a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the .TML file in the 
File Name field.  Click Save to save the selection. 

4. When the desired path and filename are selected, click Next. 

 

5. Click Export to begin exporting the TimeCoder Multimedia List file. When the progress bar reaches 

the end, the export is complete. 
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6. Review the export results carefully to ensure that no errors were encountered.  Click OK to exit the 

export process. 
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Exporting to ASCII Format 

Any transcript may be exported to ASCII (*.txt) format. To determine which format is ideal for your purposes, 

consult the product manual for the application you plan to import the transcript into. 

1. Open the DVT you want to export. 

2. Select Export to... | ASCII Transcript (*.txt) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the previous export window or 
Cancel to cancel the export. 

3. Set the export options as described below. 

Export with Page 

Breaks 
The exported transcript will contain page breaks. 

Export Double 

Spaced 
The exported transcript will be in double-spaced format. 

Export with 

Timecodes 

The timecodes that you placed in the transcript will be 

preserved in the exported transcript. This may be helpful 

when archiving your files. 

Include Milliseconds The timecodes in the exported transcript will include 

milliseconds, in addition to hours, minutes, and seconds. This 

option can only be selected if the "Export with Timecodes" 

option is also selected. 

4. Enter a destination path and filename for the exported transcript or click Browse to navigate to the 

desired folder.  

 

a. If you click Browse, the following window appears: 
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b. Select the desired destination folder and type a name for the *.txt file in the File Name field. 

Click Save to save the selection.  

5. When the desired folder and filename are selected, click Next. 

6. Click Export to begin exporting the transcript. When the progress bar reaches the end, the export 

will be complete. 

 

7. Review the export results to ensure that the operation was completed successfully. 
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8. Click OK to exit the export process. 
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Exporting to AMICUS Format 

Any transcript may be exported to AMICUS (*.ami, *.trn)  format. To determine which format is ideal for your 

purposes, consult the product manual for the application you plan to import the transcript into. 

1. Open the DVT you want to export. 

2. Select Export to... AMICUS Transcript (*.ami, *.trn) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the previous export window or 
Cancel to cancel the export. 

3. Set the export options as described below. 

Export with Page 

Breaks 
The exported transcript will contain page breaks. 

Export Double 

Spaced 
The exported transcript will be in double-spaced format. 

Export with 

Timecodes 

The timecodes that you placed in the transcript will be 

preserved in the exported transcript. This may be helpful 

when archiving your files. 

Include Milliseconds The timecodes in the exported transcript will include 

milliseconds, in addition to hours, minutes, and seconds. This 

option can only be selected if the "Export with Timecodes" 

option is also selected. 

4. Enter a destination path and filename for the exported transcript or click Browse to navigate to the 

desired folder.  
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a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.ami or *.trn file in the File 

Name field. Click Save to save the selection.  

5. When the desired folder and filename are selected, click Next. 

6. Click Export to begin exporting the transcript. When the progress bar reaches the end, the export 

will be complete. 

 

7. Review the export results to ensure that the operation was completed successfully. 
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8. Click OK to exit the export process. 
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Exporting to LiveNote / VideoNote Format 

When a synchronized DVT is exported to the LiveNote / VideoNote format, it can then be 

imported into LiveNote or VideoNote. 

Follow these steps to export LiveNote (.PTF) and VideoNote (.VID) files: 

1. Open the timecoded DVT. 

2. Select Export to... | LiveNote / VideoNote files (*.ptf)(*.vid) from the File 
menu.  The following window appears: 

 

3. Enter a destination path and filename for the *.ptf  or *.vid  file, or click [Browse] to navigate to the 

desired path and filename. 

Note:  If the *.ptf and *.vid files reside in the same directory, selecting the *.ptf will 

select the associated *.vid file, as well. 

 

If you click Browse, the following window appears: 

 

Select the desired destination folder and *.ptf file. Click Open. 

4. When the desired folder and filename are selected, click Next. 
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5. Click Export to begin exporting the DVT to LiveNote / VideoNote files.  When the progress bar 

reaches the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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Exporting to Media Player Synchronized Media Interchange 

Topics: 

 About Synchronized Media Interchange Files 

 Export DVT to Synchronized Media Interchange File 

About Synchronized Media Interchange Files 

TimeCoder has a transcript export option that will create *.smi files for use with 

The Synchronized Media Interchange (*.smi) file contains the timecoded Digital Video Transcript, specially 

  Utilizing the *.smi file format 

allows a Windows Media Player user to view synchronized transcript text. 

When the *.smi file resides next to the source multimedia file (ex. *.mpg) within the same 

folder, as shown below, Media Player will be able to use the synchronized transcript text. 

 

Enabling the Captions option within Media Player will allow any corresponding *.smi file to 

be used for text synchronization.  The example below demonstrates Media Player displaying 

a text caption from a *.smi file exported from TimeCoder. 

 

Note:  Please reference the Windows Media Player help for instructions on enabling the 

Captions option.  The method to enable Captions depends on the version of Windows 

Media Player. 
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Exporting Digital Video Transcript to *.SMI  File 

To export a Digital Video Transcript to a *.smi file 

1. Open the timecoded DVT. 

2. Select Export To... | Media Player Synchronized Accessible Media 

Interchange Files (*.smi) from the File menu. 

 

3. Enter a destination path and filename for the .SMI file, or click Browse to navigate 
to the desired path and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired output folder for the .SMI file from the Browse For Folder 
dialog.  Click OK to save the selection or Cancel to cancel the selection and 
return to the Export To... | Media Player Synchronized Accessible Media 
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Interchange Files (*.smi) window. 
  

4. When the desired path and filename are selected, click Next.  The following window appears: 

 

5. Click Export to begin exporting the *.smi file.  When the progress bar reaches the 

end, the export results are displayed, as shown below. 

 

6. Review the export results carefully to ensure that no errors were encountered.  Click 

OK to exit the export process. 
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Exporting to a Sanction II Transcript Database (*.mdb) 

When a synchronized DVT is exported to the Sanction format, it can then be imported into Sanction II. 

To export Sanction II (*.mdb) files 

1. Open a Digital Video Transcript. 

2. Select Export to... | Sanction II(TM) Transcript Database (*.mdb) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the previous export 
window or Cancel to cancel the export. 

3. Enter a destination path and filename for the *.mdb file, or click Browse to navigate to the desired 

path and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.mdb file in the File Name 

field. Click Save to save the selection.  

4. When the desired folder and filename are selected, click Next. 



TrialDirector 6 Help  Preparing Transcripts 

 Copyright ©2011 inData Corporation. All Rights Reserved. 149 

 

5. Click Export to begin exporting the DVT to Sanction files. When the progress bar reaches the end, 

the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 



TrialDirector 6 Help - Preparing Transcripts  

150 Copyright ©2011 inData Corporation. All Rights Reserved. 

Exporting to a Summation Briefcase format File (*.sbf) 

When a synchronized DVT is exported to the Summation Briefcase Format File format, it can then be 

imported into Summation Enterprise or iBlaze.   

To export Summation Briefcase Format (*.sbf) files 

1. Open a Digital Video Transcript. 

2. Select Export to... | Summation(TM) Briefcase Format File (*.sbf) from the File menu. 

 

Note: At any time during the export, you may click Back to return to the previous export 
window or Cancel to cancel the export. 

3. Enter a destination path and filename for the .sbf file, or click Browse to navigate to the desired 

folder and filename. 

  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the .sbf file in the File Name field. 

Click Save to save the selection.  
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4. When the desired folder and filename are selected, click Next. 

 

5. Click Export to begin exporting the DVT to Summation files. When the progress bar reaches the 

end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. Click OK to exit the 

export process. 
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Exporting to a Timaro Post-Production  
Timestamp File 

TimeCoder can export a Digital Video Transcript to the    

To export to a Post-production Time Stamp (*.pts) file 

1. Open a Digital Video Transcript. 

2. Select Export to... | Timaro(TM) Post-production Time Stamp file (*.pts)  from the File menu. 

 

3. Enter a destination path and filename for the *.pts file, or click Browse to navigate to the desired 

path and filename.  

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.pts file in the File Name field. 

Click Save to save the selection.  
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4. When the desired path and filename are selected, click Next. The following window appears: 

 

5. Click Export to begin exporting the Post-production Timestamp file. When the progress bar reaches 

the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 
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Exporting to a TrialPro Post-Production Timestamp File 

   

To export to a Post Production Timestamp (.pts) file 

1. Open a Digital Video Transcript. 

2. Select Export to... | Trialpro(TM) Post-Production Time Stamp file (*.pts) from the File menu. 

 

3. Enter a destination folder and filename for the *.pts file, or click Browse to navigate to the desired 

path and filename. 

a. If you click Browse, the following window appears: 

 

b. Select the desired destination folder and type a name for the *.pts file in the File Name field. 

Click Save to save the selection. 

4. When the desired path and filename are selected, click Next. 
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5. Click Export to begin exporting the Post-production Timestamp file. When the progress bar reaches 

the end, the export is complete. 

 

6. Review the export results carefully to ensure that no errors were encountered. 

7. Click OK to exit the export process. 

 

 


